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Legal Notices
CAUTION: This documentation is intended for qualified users who will exercise sound engineering judgment and expertise in the use of the Abaqus
Software. The Abaqus Software is inherently complex, and the examples and procedures in this documentation are not intended to be exhaustive or to apply
to any particular situation. Users are cautioned to satisfy themselves as to the accuracy and results of their analyses.

Dassault Systèmes and its subsidiaries, including Dassault Systèmes Simulia Corp., shall not be responsible for the accuracy or usefulness of any analysis
performed using the Abaqus Software or the procedures, examples, or explanations in this documentation. Dassault Systèmes and its subsidiaries shall not
be responsible for the consequences of any errors or omissions that may appear in this documentation.

The Abaqus Software is available only under license from Dassault Systèmes or its subsidiary and may be used or reproduced only in accordance with the
terms of such license. This documentation is subject to the terms and conditions of either the software license agreement signed by the parties, or, absent
such an agreement, the then current software license agreement to which the documentation relates.

Abaqus software updates are designated by Version, Release, and, if applicable, Maintenance Delivery. Releases are software updates that include
enhancements and new functionality. Maintenance Deliveries are software updates that address known issues but generally do not introduce enhancements
or new functionality. Abaqus Extended Functionality Releases provide early access to a subset of the new functionality that will be introduced in the
next numbered Release.

Consistent with the format used by other Dassault Systèmes brands for designating releases, Abaqus Software is designated by Version and Release as
Abaqus 6.n. Abaqus 6.n is not a new Version but is a new Release. Similarly, Abaqus 6.n-3 refers to Version 6, Release n, Maintenance Delivery 3. When
the AbaqusMaintenance Delivery number is omitted in written communications, the reference is interpreted to mean the general release, which is referenced
in the code as Abaqus 6.n-1. Extended Functionality Releases are designated by an EF suffix after the Release number.

This documentation and the software described in this documentation are subject to change without prior notice.

No part of this documentation may be reproduced or distributed in any form without prior written permission of Dassault Systèmes or its subsidiary.

The Abaqus Software is a product of Dassault Systèmes Simulia Corp., Providence, RI, USA.

© Dassault Systèmes, 2010

Abaqus, the 3DS logo, SIMULIA, CATIA, and Unified FEA are trademarks or registered trademarks of Dassault Systèmes or its subsidiaries in the United
States and/or other countries.

Other company, product, and service names may be trademarks or service marks of their respective owners. For additional information concerning
trademarks, copyrights, and licenses, see the notices at: http://www.simulia.com/products/products_legal.html.

The Abaqus Software and its documentation includes processes under U.S. Patents 5,920,491, 6,044,210, and 6,697,770. Dassault Systèmes or its
subsidiaries may also have other patents or pending patent applications, trademarks, copyrights, or other intellectual property rights covering Abaqus
Software and/or its documentation. No license of such patents, trademarks, copyrights, or other intellectual property rights is provided or implied except
as may be expressly provided in a written license agreement from Dassault Systèmes or its subsidiary.

OPEN SOURCE PROGRAMS

This release of the Abaqus Software uses several open source or free programs (“OS Programs”). Each such program is distributed with Abaqus software
in binary form and, except as permitted by the applicable license, without modification. Each such program is available online for free downloading and, if
required by the applicable OS Program license, the source code will be made available by Dassault Systèmes or its subsidiary upon request. For a complete
list of OS Programs utilized by Abaqus, as well as licensing documentation for these programs, see http://www.simulia.com/products/products_legal.html.

HP-MPI LICENSE TERMS

HP-MPI is included with this release of Abaqus software. HP-MPI is an implementation from Hewlett-Packard Company (“HP”) of the Message Passing
Interface standard that may be used for parallel execution of Abaqus/Standard, Abaqus/Explicit, and Abaqus/CFD. HP-MPI is the property of HP and is
not an Abaqus Program. Under a license from HP to Dassault Systèmes Simulia Corp., HP-MPI is made available to licensed Abaqus users at no additional
charge.
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You are a licensed Abaqus user if you are authorized to use Abaqus software under a software license agreement between Dassault Systèmes or its subsidiary
and the business, governmental, or academic entity with which you are associated. If you are a licensed Abaqus user, you may obtain HP-MPI under a
license directly from HP, or you may proceed as described in the Installation Instructions for Abaqus Programs without entering into a separate license
with HP. If you choose to install HP-MPI as made available by Dassault Systèmes or its subsidiary, use and reproduction of HP-MPI by your business,
governmental, or academic entity will be subject to the same restrictions as are in the license agreement with your business, governmental, or academic
entity that govern the use of Abaqus software and will be terminable by Dassault Systèmes or its subsidiary on the same conditions as are in the Abaqus
software license agreement. However, HP-MPI is NOT an Abaqus Program and is NOT warranted or supported by Dassault Systèmes or its subsidiaries.
Without limiting the foregoing:

HP-MPI IS PROVIDED “AS IS” AND WITHOUT ANY WARRANTY. DASSAULT SYSTÈMES, ITS SUBSIDIARIES, AND HP SPECIFICALLY
DISCLAIM ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING ANY WARRANTIES OF NON-INFRINGEMENT OR OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL DASSAULT SYSTÈMES, ITS SUBSIDIARIES, OR HP BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
PUNITIVE, SPECIAL OR CONSEQUENTIAL DAMAGE (INCLUDING WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS
PROFITS, BUSINESS INTERRUPTION, OR LOSS OF BUSINESS INFORMATION) ARISING FROM USE OR ATTEMPTED USE OF HP-MPI,
EVEN IF DASSAULT SYSTÈMES, ITS SUBSIDIARIES, OR HP HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

MS-MPI LICENSE TERMS

MS-MPI is included with this release of Abaqus software. MS-MPI is an implementation fromMicrosoft Corporation (“Microsoft”) of the Message Passing
Interface standard that may be used for parallel execution of Abaqus/Standard, Abaqus/Explicit, and Abaqus/CFD. MS-MPI is the property of Microsoft
and is not an Abaqus Program. Under a license from Microsoft to Dassault Systèmes Simulia Corp., MS-MPI is made available to licensed Abaqus users
at no additional charge.

You are a licensed Abaqus user if you are authorized to use Abaqus software under a software license agreement between Dassault Systèmes or its subsidiary
and the business, governmental, or academic entity with which you are associated. If you are a licensed Abaqus user, you may obtain MS-MPI under a
license directly fromMicrosoft, or you may proceed as described in the Installation Instructions for Abaqus Programs without entering into a separate license
with Microsoft. If you choose to use MS-MPI as made available by Dassault Systèmes or its subsidiary, use and reproduction of MS-MPI by your business,
governmental, or academic entity will be subject to the restrictions as stated in the MS-MPI license agreement below (see “MICROSOFT SOFTWARE
LICENSE TERMS”), and will be terminable by Microsoft under the conditions in that software license agreement. MS-MPI is NOT an Abaqus Program
and is NOT warranted or supported by Dassault Systèmes or its subsidiaries. Without limiting the foregoing:

MICROSOFT SOFTWARE LICENSE TERMS

MICROSOFT HPC Pack MS-MPI Redistributable Pack

These license terms are an agreement between Microsoft Corporation (or based on where you live, one of its affiliates) and you. Please read them. They
apply to the software named above, which includes the media on which you received it, if any. The terms also apply to any Microsoft

• updates,
• supplements,
• Internet-based services, and
• support services

for this software, unless other terms accompany those items. If so, those terms apply.

BY USING THE SOFTWARE, YOU ACCEPT THESE TERMS. IF YOU DO NOT ACCEPT THEM, DO NOT USE THE SOFTWARE.

If you comply with these license terms, you have the rights below.

1. INSTALLATION AND USE RIGHTS. You may install and use any number of copies of the software on your premises as follows:
• Individual Use. You may install and use the software with third party programs designed and developed for use with the software.
• Production Use. You may install and use any number of copies of the software on your premises to design, develop, test and demonstrate

your programs.

Abaqus ID:

Printed on:



2. RIGHT TO DISTRIBUTE. If you comply with the terms below you may copy and distribute the object code form of the software listed in the
REDIST.TXT file in conjunction with the programs you develop. Further, you may permit distributors of your programs to copy and distribute the
software as part of those programs you create.

a. Distribution Requirements. If you distribute the software, you must:
• add significant primary functionality to it in your programs;
• require distributors and external end users to agree to terms that protect it at least as much as this agreement;
• display your valid copyright notice on your programs; and
• indemnify, defend, and hold harmless Microsoft from any claims, including attorneys’ fees, related to the distribution or use of your

programs.
b. Distribution Restrictions. You may not

• alter any copyright, trademark or patent notice in the software;
• use Microsoft’s trademarks in your programs’ names or in a way that suggests your programs come from or are endorsed by Microsoft;
• distribute the software to run on a platform other than the Windows platform;
• include the software in malicious, deceptive or unlawful programs; or
• modify or distribute the source code of the software so that any part of it becomes subject to an Excluded License. An Excluded

License is one that requires, as a condition of use, modification or distribution, that
– the code be disclosed or distributed in source code form; or
– others have the right to modify it.

3. Scope of License. The software is licensed, not sold. This agreement only gives you some rights to use the software. Microsoft reserves all other
rights. Unless applicable law gives you more rights despite this limitation, you may use the software only as expressly permitted in this agreement.
In doing so, you must comply with any technical limitations in the software that only allow you to use it in certain ways. You may not

• work around any technical limitations in the software;
• reverse engineer, decompile or disassemble the software, except and only to the extent that applicable law expressly permits, despite this

limitation;
• make more copies of the software than specified in this agreement or allowed by applicable law, despite this limitation;
• publish the software for others to copy;
• rent, lease or lend the software;
• transfer the software or this agreement to any third party (except as permitted in Section 2); or
• use the software for commercial software hosting services.

4. BACKUP COPY. You may make one backup copy of the software. You may use it only to reinstall the software.

5. DOCUMENTATION. Any person that has valid access to your computer or internal network may copy and use the documentation for your internal,
reference purposes.

6. Export Restrictions. The software is subject to United States export laws and regulations. Youmust comply with all domestic and international export
laws and regulations that apply to the software. These laws include restrictions on destinations, end users and end use. For additional information,
see www.microsoft.com/exporting.

7. SUPPORT SERVICES. Because this software is "as is," we may not provide support services for it.

8. Entire Agreement. This agreement, and the terms for supplements, updates, Internet-based services and support services that you use, are the entire
agreement for the software and support services.
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9. Applicable Law.

a. United States. If you acquired the software in the United States, Washington state law governs the interpretation of this agreement and applies
to claims for breach of it, regardless of conflict of laws principles. The laws of the state where you live govern all other claims, including
claims under state consumer protection laws, unfair competition laws, and in tort.

b. Outside the United States. If you acquired the software in any other country, the laws of that country apply.

10. Legal Effect. This agreement describes certain legal rights. You may have other rights under the laws of your country. You may also have rights
with respect to the party from whom you acquired the software. This agreement does not change your rights under the laws of your country if the
laws of your country do not permit it to do so.

11. Disclaimer of Warranty. The software is licensed “as-is.” You bear the risk of using it. Microsoft gives no express warranties, guarantees or
conditions. You may have additional consumer rights under your local laws which this agreement cannot change. To the extent permitted under your
local laws, Microsoft excludes the implied warranties of merchantability, fitness for a particular purpose and non-infringement.

12. Limitation on and Exclusion of Remedies and Damages. You can recover from Microsoft and its suppliers only direct damages up to U.S. $5.00.
You cannot recover any other damages, including consequential, lost profits, special, indirect or incidental damages.

This limitation applies to
• anything related to the software, services, content (including code) on third party Internet sites, or third party programs; and
• claims for breach of contract, breach of warranty, guarantee or condition, strict liability, negligence, or other tort to the extent permitted by

applicable law.
It also applies even if Microsoft knew or should have known about the possibility of the damages. The above limitation or exclusion may not apply
to you because your country may not allow the exclusion or limitation of incidental, consequential or other damages.

Please note: As this software is distributed in Quebec, Canada, some of the clauses in this agreement are provided below in French.

Remarque: Ce logiciel étant distribué au Québec, Canada, certaines des clauses dans ce contrat sont fournies ci-dessous en français.

EXONÉRATION DE GARANTIE. Le logiciel visé par une licence est offert « tel quel ». Toute utilisation de ce logiciel est à votre seule risque et
péril. Microsoft n’accorde aucune autre garantie expresse. Vous pouvez bénéficier de droits additionnels en vertu du droit local sur la protection des
consommateurs, que ce contrat ne peut modifier. Là où elles sont permises par le droit locale, les garanties implicites de qualité marchande, d’adéquation
à un usage particulier et d’absence de contrefaçon sont exclues.

LIMITATION DES DOMMAGES-INTÉRÊTS ET EXCLUSION DE RESPONSABILITÉ POUR LES DOMMAGES. Vous pouvez obtenir de Microsoft
et de ses fournisseurs une indemnisation en cas de dommages directs uniquement à hauteur de 5,00 $ US. Vous ne pouvez prétendre à aucune indemnisation
pour les autres dommages, y compris les dommages spéciaux, indirects ou accessoires et pertes de bénéfices.

Cette limitation concerne:
• tout ce qui est relié au logiciel, aux services ou au contenu (y compris le code) figurant sur des sites Internet tiers ou dans des programmes tiers ; et
• les réclamations au titre de violation de contrat ou de garantie, ou au titre de responsabilité stricte, de négligence ou d’une autre faute dans la limite

autorisée par la loi en vigueur.
Elle s’applique également, même si Microsoft connaissait ou devrait connaître l’éventualité d’un tel dommage. Si votre pays n’autorise pas l’exclusion ou
la limitation de responsabilité pour les dommages indirects, accessoires ou de quelque nature que ce soit, il se peut que la limitation ou l’exclusion ci-dessus
ne s’appliquera pas à votre égard.

EFFET JURIDIQUE. Le présent contrat décrit certains droits juridiques. Vous pourriez avoir d’autres droits prévus par les lois de votre pays. Le présent
contrat ne modifie pas les droits que vous confèrent les lois de votre pays si celles-ci ne le permettent pas.
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INTRODUCTION TO Abaqus 6.10-EF

1. Introduction to Abaqus 6.10-EF

This document introduces features in Abaqus that have been added, enhanced, or updated since the

Abaqus 6.10 release.

Chapter 1 provides a brief overview of the Abaqus products included in this release. Chapters 2–15

provide short descriptions of new Abaqus 6.10-EF features in Abaqus/Standard, Abaqus/Explicit,

Abaqus/CFD, and Abaqus/CAE, categorized by subject:

• Chapter 2, “General enhancements”: general changes to the Abaqus interface.

• Chapter 3, “Execution”: commands and utilities for running any of the Abaqus products.

• Chapter 4, “Modeling”: features related to creating your model, such as node and element definition in

Abaqus/Standard or Abaqus/Explicit and part and assembly definition in Abaqus/CAE.

• Chapter 5, “Model import and export”: features related to importing and exporting parts, assemblies,

and models to or from Abaqus/CAE.

• Chapter 6, “Analysis procedures”: features related to defining an analysis.

• Chapter 7, “Materials”: new material models or changes to existing material models.

• Chapter 8, “Elements”: new elements or changes to existing elements.

• Chapter 9, “Prescribed conditions”: loads, boundary conditions, and predefined fields.

• Chapter 10, “Constraints”: kinematic constraints.

• Chapter 11, “Interactions”: features related to contact and interaction modeling.

• Chapter 12, “Meshing”: features related to meshing your model.

• Chapter 13, “Output and visualization”: obtaining, postprocessing, and visualizing results from Abaqus

analyses.

• Chapter 14, “User subroutines, utilities, and plug-ins”: additional user programs that can be run with

Abaqus.

• Chapter 15, “Abaqus Scripting Interface”: using the Abaqus Scripting Interface to write user scripts.

Each entry in these chapters clearly indicates the Abaqus product or products to which the feature applies

and includes cross-references to more detailed information. Chapter 16, “Summary of changes,” summarizes

in tabular format the changes to Abaqus elements, keyword options, user subroutines, and output variable

identifiers.

1.1 Key features of Abaqus 6.10-EF

This section provides brief descriptions of some of the most significant new capabilities and enhancements

available in the Abaqus 6.10 Extended Functionality release; refer to the table of contents for a complete list

of new features.

1–1
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INTRODUCTION TO Abaqus 6.10-EF

• Pressure penetration loading, including support in Abaqus/CAE, is now available for three-dimensional

models (“Three-dimensional pressure penetration loading,” Section 9.1).

• You can now use Abaqus/CAE to create substructures, to import substructures into your model database,

to add substructures to your assembly, and to recover substructure output data during an analysis

(“Substructures in Abaqus/CAE,” Section 4.1).

• Enhancements to the extended finite element method (XFEM) include support for a user-defined damage

initiation criterion and for simulation of low-cycle fatigue using XFEM and the direct cyclic approach

(“Continued enhancements to the XFEM-based crack propagation capability,” Section 6.2).

• You can obtain improved accuracy for modeling contact interactions with gasket elements (“Penalty

stiffness for contact involving gaskets,” Section 11.2).

• Contact stress output is more accurate and less noisy for second-order surfaces (“Contact stress output

improvements,” Section 11.1).

• Output enhancements reduce the size of the output database, including changing the extrapolation and

interpolation schemes in Abaqus/Standard for three commonly used output variables: stress, Mises

equivalent stress, and equivalent pressure stress (“Output database size reduction,” Section 13.1).

• Timoshenko beams in Abaqus/Standard now support linearly tapered general beam sections and standard

library sections (“Tapered beams and improved mass formulation,” Section 8.2).

• New scalable thread-parallel execution capability of the AMS eigensolver significantly improves

the performance of frequency extraction analyses (“AMS eigensolver performance improvement,”

Section 6.5).

• The iterative solver algorithm offers improved handling of dense linear constraints to better achieve

convergence (“Enhanced iterative solver capability to handle dense linear constraints,” Section 6.6).

• More efficient and robust edge-to-edge contact interactions in general contact are available in

Abaqus/Explicit (“Edge-to-edge general contact enhancement,” Section 11.3).

• Abaqus/Aqua loading to apply wave drag and buoyancy loading to structures modeled using pipe and

beam elements is now available with Abaqus/Explicit (“Explicit dynamics analysis using Abaqus/Aqua,”

Section 9.5).

• Abaqus/CFD provides support for the RNG k– turbulence model, which is a two-equation model based

on renormalization group theory that accounts for the effects of small scales of motion (“New RNG

k–epsilon turbulence model for fluid dynamic analysis,” Section 6.3).

• Modeling enhancements in Abaqus/CAE include the option to mirror a part and retain the complete

feature creation history and the ability to edit those features (“Adding a mirror feature to a part,”

Section 4.5).

• Material calibration, which is the process of deriving Abaqus material behaviors from sets of material test

data, can now be performed in Abaqus/CAE to derive linear isotropic elasticity and isotropic plasticity

without hardening material behaviors (“Material calibration,” Section 7.1).

• Mesh stack orientation enhancements, including assigning a stack direction based on the orientation of

a reference face and assigning stack orientations that are independent of the sweep direction, are now

available in Abaqus/CAE (“Mesh stack orientations,” Section 12.2).
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• Several enhancements are available for visualizing results:

– Streamlines can be used to visualize the velocity and vorticity of fluid flow in an Abaqus/CFD

analysis (“Streamlines,” Section 13.2).

– New options for probing the model offer more customization and improve usability (“Enhanced

query options for probing the model,” Section 13.5).

Abaqus 6.10-EF general release products are available on DVD-ROM. Limited availability products are

available on the SIMULIA ftp site. Contact your local office or representative for details. Products supported

on each of the following combinations of supported operating systems and processors are summarized

in Table 1–1. Interactive products include Abaqus/CAE and Abaqus/Viewer. Analysis products include

Abaqus/Standard, Abaqus/Explicit, and Abaqus/CFD.

Table 1–1 Overview of platform and product support.

Platform Availability Supported products

Windows/x86-32 DVD Interactive and analysis products

Windows/x86-64 DVD Interactive and analysis products

Linux/x86-64 DVD Interactive and analysis products

Linux/Itanium ftp Abaqus/Standard and Abaqus/Explicit

AIX/Power ftp Analysis products

For current and complete details on supported Abaqus products and platforms, including platform

information for add-on products, interfaces, and translators, refer to the Abaqus systems information

available through the Support page at www.simulia.com. For more information, see Appendix A, “System

requirements,” of the Abaqus Installation and Licensing Guide.

The remaining chapters in this book provide details on these and other new features of Abaqus 6.10-EF.

In addition to the enhancements listed here, most of the known bugs in Abaqus 6.10 are corrected.

1.2 Abaqus products

Individual components of the Abaqus suite are described in this section.

Analysis
• Abaqus/Standard: This general-purpose finite element analysis program includes all analysis

capabilities except nonlinear dynamic analysis using explicit time integration (provided in the

Abaqus/Explicit program), computational fluid dynamics capabilities, and the add-on analysis

functionality described below.
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• Abaqus/Explicit: This product provides nonlinear, transient, dynamic analysis of solids and structures

using explicit time integration. Its powerful contact capabilities, reliability, and computational efficiency

on large models also make it highly effective for quasi-static applications involving discontinuous

nonlinear behavior.

• Abaqus/CFD: This product is a computational fluid dynamics program with extensive support for

preprocessing, simulation, and postprocessing in Abaqus/CAE. Abaqus/CFD provides scalable parallel

CFD simulation capabilities to address a number of nonlinear coupled fluid-thermal and fluid-structural

problems.

Preprocessing and postprocessing
• Abaqus/CAE: This product is a Complete Abaqus Environment that provides a simple, consistent

interface for creating, submitting, monitoring, and evaluating results from Abaqus simulations.

Abaqus/CAE is divided into modules, where each module defines a logical aspect of the modeling

process; for example, defining the geometry, defining material properties, generating a mesh, submitting

analysis jobs, and interpreting results.

• Abaqus/Viewer: This subset of Abaqus/CAE contains only the postprocessing capabilities of the

Visualization module. It uses the output database (.odb) to obtain results from the analysis products.

The output database is a neutral binary file. Therefore, results from an Abaqus analysis run on any

platform can be viewed on any other platform supporting Abaqus/Viewer. It provides deformed

configuration, contour, vector, and X–Y plots, as well as animation of results.

Add-on analysis
• Abaqus/Aqua: This add-on analysis capability for Abaqus/Standard and Abaqus/Explicit provides a

capability for calculating drag and buoyancy loads based on steady current, wave, and wind effects for

modeling offshore piping and floating platform structures. Abaqus/Aqua is applicable for structures that

can be idealized using line elements, including beam, pipe, and truss elements.

• Abaqus/Design: This add-on analysis capability for Abaqus/Standard allows the user to perform

design sensitivity analysis (DSA). The derivatives of output variables are calculated with respect to

specified design parameters.

• Abaqus/Foundation: This analysis option offers more efficient access to the linear static and dynamic

analysis functionality in Abaqus/Standard.

• CZone for Abaqus: This add-on capability for Abaqus/Explicit provides access to a state-of-the-art

methodology for crush simulation based on CZone technology from Engenuity, Ltd. Targeted toward the

design of composite components and assemblies, CZone for Abaqus provides for inclusion of material

crush behavior in simulations of composite structures subjected to impact.
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Optional analysis functionality
• Abaqus/AMS: This add-on analysis capability for Abaqus/Standard allows the user to select

the automatic multi-level substructuring (AMS) eigensolver when performing a natural frequency

extraction.

• Co-simulation with MpCCI: This add-on analysis capability for Abaqus can be used to solve

multiphysics problems by coupling Abaqus with any third-party analysis program that supports the

MpCCI interface.

• Co-simulation with MADYMO: This add-on analysis capability for Abaqus/Explicit can be used to

perform vehicle-occupant crash safety simulations by coupling Abaqus/Explicit with MADYMO.

Interfaces
• Abaqus Interface for Moldflow: This optional interface translates finite element model information

from a Moldflow analysis to an Abaqus input file.

• Abaqus Interface for MSC.ADAMS: This optional interface allows Abaqus finite element models

to be included as flexible components within the MSC.ADAMS family of products. The interface is

based on the component mode synthesis formulation of ADAMS/Flex. Specifically, flexibility data

from Abaqus superelements are translated to the modal neutral (.mnf) file format required by the

ADAMS/Flex product. Although the ADAMS/Flex interface supports only linear flexibility data, the

Abaqus user may include an arbitrary number of preloading steps before the linear flexibility data are

obtained. Multiple flexible components generated by Abaqus can be included in an MSC.ADAMS

model. Most Abaqus structural elements are supported by the interface.

Associative interfaces and geometry translators
• CATIA V5 Associative Interface: This add-on capability for Abaqus/CAE creates a connection

between a CATIA V5 session and an Abaqus/CAE session. This connection can be used to transfer

model information from CATIA V5 to Abaqus/CAE. Subsequent modifications to the model in

CATIA V5 can be propagated to the Abaqus/CAE model while retaining any analysis features (such

as loads or boundary conditions) that were defined on the model in Abaqus/CAE. The geometry of

CATIA V5-format Part (.CATPart) and Product (.CATProduct) files can also be imported directly

into Abaqus/CAE.

• SolidWorks Associative Interface: This add-on capability for Abaqus/CAE creates a connection

between a SolidWorks session and an Abaqus/CAE session. This connection can be used to transfer

model information from SolidWorks to Abaqus/CAE. Subsequent modifications to the model in

SolidWorks can be propagated to the Abaqus/CAE model while retaining any analysis features (such as

loads or boundary conditions) that were defined on the model in Abaqus/CAE.

• Pro/ENGINEER Associative Interface: This add-on capability for Abaqus/CAE creates a

connection between a Pro/ENGINEER session and an Abaqus/CAE session. This connection can be

used to transfer model information between Pro/ENGINEER and Abaqus/CAE. Modifications to the
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model in Pro/ENGINEER can be propagated to the Abaqus/CAE model without affecting any analysis

features (such as loads or boundary conditions) that were defined on the model in Abaqus/CAE,

and certain geometric modifications can be made in Abaqus/CAE and propagated to the model in

Pro/ENGINEER.

• NX Associative Interface: This add-on capability for Abaqus/CAE creates a connection between

an NX session and an Abaqus/CAE session. This connection can be used to transfer model data and

to propagate design changes between NX and Abaqus/CAE. The NX Associative Interface can be

purchased and downloaded from Elysium Inc. (www.elysiuminc.com).

• Geometry Translator for CATIA V4: This add-on capability allows the user to import the geometry

of CATIA V4-format parts and CATIA V4 assemblies (.model, .catdata, and .exp files) directly

into Abaqus/CAE.

• Geometry Translator for I-DEAS: This translator plug-in for I-DEAS generates a geometry file

using the Elysium Neutral File (.enf) or Elysium Neutral Assembly File (.eaf) format, which can be

imported into Abaqus/CAE.

• Geometry Translator for Parasolid: This add-on capability allows the user to import the geometry

of Parasolid-format parts and Parasolid assemblies (.x_t, .x_b, and .xmt files) directly into

Abaqus/CAE.

Translator utilities

• Abaqus translators are provided with the release. They are invoked through the Abaqus execution

procedure (the “driver”). The translators and the commands to invoke them are described below:

abaqus fromansys translates an ANSYS input file to an Abaqus input file.

abaqus fromnastran translates a Nastran bulk data file to an Abaqus input file.

abaqus frompamcrash translates a PAM-CRASH input file to a partial Abaqus input file.

abaqus fromradioss translates a RADIOSS input file to a partial Abaqus input file.

abaqus tonastran translates an Abaqus input file to Nastran bulk data file format.

abaqus toOutput2 translates an Abaqus output database file to the Nastran Output2 file format.

abaqus tozaero enables you to exchange aeroelastic data between the Abaqus and ZAERO analysis

products.

Other utilities
• Additional programs are included with the release. They are all invoked through the Abaqus execution

procedure (the “driver”). The utilities and the commands to invoke these programs are described below:

abaqus append joins separate results files into a single file.

abaqus ascfil translates Abaqus results files between ASCII and binary formats, which is useful for

moving results files between different computer types.

abaqus doc accesses the Abaqus documentation collection using a web browser.
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abaqus encrypt creates an encoded, password-protected version of an Abaqus input file,

while abaqus decrypt converts an encrypted file back into its original, unencoded format.

abaqus fetch extracts example input files from the libraries included with the release.

abaqus findkeyword provides a list of sample problems that use the specified Abaqus options. This

utility will help users find examples of features they may be using for the first time.

abaqus free converts all fixed format data in an input file to free format.

abaqus licensing provides a summary of Abaqus license usage reporting and the available

FLEXnet Licensing utilities.

abaqus make compiles and links user-written postprocessing programs for Abaqus and creates

user-defined libraries of Abaqus/Standard and Abaqus/Explicit user subroutines.

abaqus networkDBConnector creates a connection to a network ODB server that can be used to

access a remote output database.

abaqus restartjoin appends an output database file produced by a restart analysis of a model to the

output database produced by the original analysis of that model.

abaqus odbcombine combines the results data in two or more Abaqus output database files into a

single output database file.

abaqus odbreport creates organized reports of output database information in text, HTML, or CSV

file formats.

abaqus python accesses the Python interpreter.

abaqus resume resumes an Abaqus analysis job.

abaqus script initiates a Python scripting session.

abaqus substructurecombine combines the model and results data produced by two of a model’s

substructures into a single output database file.

abaqus suspend suspends an Abaqus analysis job.

abaqus terminate terminates an Abaqus analysis job.

abaqus upgrade upgrades an input file or output database file from previous versions of Abaqus to

the current version.

Changes to documentation
• When installing Abaqus, if you have installed both the PDF and HTML versions of the documentation,

you now have the option of choosing the format that the abaqus doc command will open. See

“Abaqus product installation,” Section 2.1.3 of the Abaqus Installation and Licensing Guide.

• The PDF version of the Abaqus Keywords Reference Manual now consists of one volume. The manual

contains the same content as before. The volume division was removed to ease searching in the PDF

version.

• Search hit counts in the HTMLmanuals are now displayed for every level of the table of contents. Search

hit highlighting has been enhanced such that if you use the table of contents to open a section containing

search hits, it first opens to the section title rather than to the first hit. Then you can use the Next Match

1–7

Abaqus ID:

Printed on:



INTRODUCTION TO Abaqus 6.10-EF

button to jump to the first search result in that section. If you are already reading a manual, conducting

a new search will also reload the current page to the section title.

1.3 Changes in interpretation of input data

The following change in Abaqus 6.10-EF may impact the analysis of input files from previous releases of

Abaqus:

• The enhanced general contact tracking algorithm for edge-to-edge contact in Abaqus/Explicit is now

used by default (*CONTACTCONTROLSASSIGNMENT, TYPE=ENHANCEDEDGETRACKING).

This algorithm utilizes more local information than the alternative tracking algorithm (TYPE=EDGE

TRACKING) in tracking contact between edges and typically reduces the extent of global tracking

required.

For a complete list of changes to the Abaqus input file interface, refer to Chapter 16, “Summary of changes.”
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2. General enhancements

This chapter describes the following general enhancements that have been made to Abaqus:

• “Enhancements to the Abaqus installer,” Section 2.1

• “Context bar list navigation in Abaqus/CAE,” Section 2.2

• “Copying step-dependent objects to a different step,” Section 2.3

2.1 Enhancements to the Abaqus installer

Benefits: Several installer enhancements simplify Abaqus client installation and setup.

Description: The Abaqus installer has the following new features in Abaqus 6.10-EF:

• If you are installing Abaqus on a Windows–mounted network drive (to be run from client Windows

computers), you can enter a Universal NamingConvention (UNC) path as the target installation directory;

for example: \\ComputerName\SharedFolder\path. Microsoft UNC paths can be used instead of

Windows–mapped drive paths.

• If you run the Windows client installer with Windows Administrator privileges, it will install the Abaqus

prerequisite libraries as follows:

– OnWindows/x86-64 platforms, the requiredMicrosoft Visual C++ libraries andMicrosoft Message

Passing Interface (MPI) libraries are both installed.

– On Windows/x86-32 platforms, the Microsoft Visual C++ libraries are installed. The GUI installer

for the Hewlett-Packard HP Message Passing Interface library (HP-MPI) cannot run in the client

installer. To install the HP-MPI libraries separately, see the instructions in “Visual C++ and MPI

Libraries,” Section 2.4.1 of the Abaqus Installation and Licensing Guide.

MPI components must be installed to use MPI-based parallel job execution in

Abaqus/Standard, to use domain-level parallelization in Abaqus/Explicit, or to run any job in

Abaqus/CFD (regardless of the number of CPUs). If your Abaqus users will be running these

types of simulations, you must have the required MPI components.

References:

Abaqus Installation and Licensing Guide

• “Information to enter during product installation,” Section 2.4.2

• “Client installation for Windows,” Section 2.4.4
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2.2 Context bar list navigation in Abaqus/CAE

Product: Abaqus/CAE

Benefits: Up and down buttons on the context bar drop-down lists allow you to move quickly to the previous

item or next item.

Description: The context bar contains the Module drop-down list for moving to different modules within

Abaqus/CAE. As shown in Figure 2–1, new up and down arrows (to the left) now allow you to move to the

previous module or next module with a single click. Similar arrows are added to all other lists that appear on

the context bar.

Figure 2–1 List navigation in the context bar.

Reference:

Abaqus/CAE User’s Manual

• “The context bar,” Section 2.2.4

2.3 Copying step-dependent objects to a different step

Product: Abaqus/CAE

Benefits: When copying a step-dependent object such as a load or boundary condition, you can now choose

a different destination step for the copied object. This enhancement improves usability and saves time when

working with multistep analyses in Abaqus/CAE.

Description: Using the Abaqus/CAE object manager dialog boxes, menu commands, or Model Tree,

you can copy loads, boundary conditions, interactions, predefined fields, output requests, or adaptive mesh

constraints. In previous releases of Abaqus/CAE, these objects could only be copied into the same step.

You can now choose another valid step of the analysis as the destination for the copied object, as shown in

Figure 2–2.
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Figure 2–2 Copying objects to another step.

Abaqus/CAE Usage:
Various modules:

Load Manager, Boundary Condition Manager, Interaction Manager, Predefined Field Manager,
Field Output Requests Manager, History Output Requests Manager, or
ALE Adaptive Mesh Constraint Manager;
select object; Copy; Step: destination step

Reference:

Abaqus/CAE User’s Manual

• “Copying step-dependent objects using manager dialog boxes,” Section 3.4.11, in the online HTML

version of this manual
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3. Execution

This chapter discusses commands and utilities for running the Abaqus products. It provides an overview of

the following enhancements:

• “Parallel ordering for the direct sparse solver,” Section 3.1

• “Thread parallel element and contact search calculations for transient fidelity dynamic analyses,”

Section 3.2

• “Parallel support for Abaqus/Standard to Abaqus/Standard import,” Section 3.3

• “Parallel support for Abaqus/Standard co-simulation,” Section 3.4

3.1 Parallel ordering for the direct sparse solver

Product: Abaqus/Standard

Benefits: The parallel ordering procedure for the direct sparse solver has been improved to give higher

quality orderings, resulting in improved solver performance.

Description: The parallel ordering procedure for the direct sparse solver has been improved to generate

higher quality orderings for improved solver performance. The procedure will now run on multiple host

machines in a cluster configuration.

Reference:

Abaqus Analysis User’s Manual

• “Parallel execution in Abaqus/Standard,” Section 3.5.2

3.2 Thread parallel element and contact search calculations for
transient fidelity dynamic analyses

Product: Abaqus/Standard

Benefits: Thread-parallel execution of additional calculations provides improved performance for many

dynamic analyses.

Description: Dynamic analyses with transient fidelity application settings now execute element and contact

search calculations with thread-based parallelization among processors of a compute node, which is similar

to the existing behavior for moderate dissipation and quasi-static application settings. In previous Abaqus

releases, these calculations were performed on only one processor per compute node.
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Reference:

Abaqus Analysis User’s Manual

• “Parallel execution in Abaqus/Standard,” Section 3.5.2

3.3 Parallel support for Abaqus/Standard to Abaqus/Standard import

Product: Abaqus/Standard

Benefits: Abaqus/Standard to Abaqus/Standard import analyses can now benefit from MPI-based

parallelization.

Description: MPI-based parallel Abaqus/Standard to Abaqus/Standard import analyses are now supported.

Reference:

Abaqus Analysis User’s Manual

• “Parallel execution in Abaqus/Standard,” Section 3.5.2

3.4 Parallel support for Abaqus/Standard co-simulation

Product: Abaqus/Standard

Benefits: Abaqus/Standard analyses that use the co-simulation technique can now benefit from MPI-based

parallelization.

Description: Abaqus/Standard co-simulation analyses can be executed using MPI-based parallelization.

For example, this new feature will benefit your Abaqus/Standard to Abaqus/Explicit co-simulation.

Reference:

Abaqus Analysis User’s Manual

• “Parallel execution in Abaqus/Standard,” Section 3.5.2
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4. Modeling

This chapter discusses features related to creating your model, such as node and element definition in

Abaqus/Standard or Abaqus/Explicit and part and assembly definition in Abaqus/CAE. It provides an

overview of the following enhancements:

• “Substructures in Abaqus/CAE,” Section 4.1

• “Application of fluid cavity pressure on the fluid exchange surface,” Section 4.2

• “Enhancements to the offset, extend, and blend face tools,” Section 4.3

• “Creating a wire-from-edge feature,” Section 4.4

• “Adding a mirror feature to a part,” Section 4.5

• “Diagnostics for modeling errors associated with mass properties,” Section 4.6

• “Thickness and material orientation distributions for membrane elements and sections,” Section 4.7

• “Composite layer thickness distribution for shell elements,” Section 4.8

4.1 Substructures in Abaqus/CAE

Product: Abaqus/CAE

Benefits: Abaqus/CAE now supports substructure generation, usage, and recovery. These enhancements

expand the scope of modeling capabilities in Abaqus/CAE and enable you to perform analyses with improved

performance.

Description: Abaqus/CAE now enables you to create substructures, import them into your model database,

add them to your assembly, and recover their output data during an analysis. The enhancements fall into three

categories: substructure generation, substructure usage, and substructure recovery.

• The newSubstructure generation step definition enables you to control several aspects of substructure

generation in your analysis, including its recovery region, generation options, retained eigenmodes,

and damping controls. Multiple preloading steps can precede the substructure generation step in your

analysis.

Once you specify a substructure generation step, you can create a boundary condition to specify the

retained nodal degrees of freedom for nodes or regions in the substructure. These retained degrees of

freedom are displayed in light blue in the viewport, and you can select them when you create assembly

constraints.

• You can use substructures in your model by first importing them into the model database as new part

definitions. The new Create Substructure Part dialog box enables you to customize the name of the

new substructure part you import and to specify the output database file containing the mesh you want

to display for the selected substructure.
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Once imported, you can instance a substructure-based part in Abaqus/CAE in the same way that you

can for any other part definitions, and you can translate and perform other manipulations on substructure

part instances using the same tools you use to manipulate the other part instances in your assembly.

Abaqus/CAE distinguishes substructure part instances by displaying them with a translucent color by

default. Figure 4–1 shows a model of a backhoe in which one component, the dipper, has been modeled

with a substructure part instance.

Figure 4–1 Translucent display of a substructure part instance in a backhoe model.

• You can now request field output for one or more sets in a substructure. If you specify the Substructure
as the Domain for your request, the field output editor enables you to open the Select Substructure
Sets dialog box to select the set or sets for which you want to recover output within one or more

substructure part instances. Figure 4–2 displays this dialog box with five sets selected for output in

the first substructure part instance, FAN_Z114-1.
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Figure 4–2 Select Substructure Sets dialog box.

Abaqus/CAE Usage:
All modules:

File→Import→Part: File Filter: Substructure: select .sim file

Step module:

Output→Field Output Requests→Create: Domain: Substructure
Step→Create: Procedure type: Linear perturbation: Substructure generation

Load module:

BC→Create: Mechanical: Retained nodal dofs

References:

Abaqus Analysis User’s Manual

• “Substructuring,” Section 10.1
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Abaqus/CAE User’s Manual

• “Importing a substructure into a model database as a part,” Section 10.7.13, in the online HTML version

of this manual

• “Configuring a substructure generation procedure” in “Configuring linear perturbation analysis

procedures,” Section 14.11.2, in the online HTML version of this manual

• “Modifying field output requests,” Section 14.12.2, in the online HTML version of this manual

• “Using the boundary condition editors,” Section 16.10, in the online HTML version of this manual

• Chapter 38, “Substructures”

4.2 Application of fluid cavity pressure on the fluid exchange surface

Product: Abaqus/Explicit

Benefits: You can now specify that the fluid cavity pressure should be applied to the fluid exchange surface

as an equivalent load on the periphery of the surface.

Description: The fluid exchange surface is part of a fluid cavity, and the cavity pressure is applied on it

by default. If the fluid exchange surface represents a vent and is meshed such that it includes nodes away

from its perimeter, the cavity pressure acting on the vent surface can lead to local bulging due to the typically

soft stiffness used to represent the vent. The local bulging may lead to inaccurate leakage area computation,

thus affecting the mass flow through the vent. To model the fluid exchange through a vent, Abaqus/Explicit

provides an option to apply an equivalent line pressure load on the vent periphery.

References:

Abaqus Analysis User’s Manual

• “Fluid exchange definition,” Section 11.6.3

Abaqus Keywords Reference Manual

• *FLUID EXCHANGE

Abaqus Verification Manual

• “Surface-based fluid cavities,” Section 5.1.23

4.3 Enhancements to the offset, extend, and blend face tools

Product: Abaqus/CAE

Benefits: Three of the face editing tools added in Abaqus 6.10 have been enhanced in the current release.

Enhancements to the offset, extend, and blend tools for editing faces simplify the operations, reduce the need
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for viewport selections, and add new control options for use when you edit models or create midsurface

models.

Description: The Offset Faces operation now includes an option that allows Abaqus/CAE to select target

faces automatically for determining the offset distance. The new Auto Select button shown in Figure 4–3 is

available only when the faces to offset are part of the reference representation used for creating a midsurface

model. When you use automatic selection, Abaqus/CAE considers faces from the opposite side of the

midsurface region from those that you selected to offset.

Figure 4–3 The Auto Select option in the Offset Faces dialog box.

The Extend Faces operation has two new options available if you use target faces to determine the

extension distance. You can choose whether Abaqus/CAE extends the target faces (temporarily) to create

intersections with the faces that you are extending. The Trim to extended underlying target surfaces
option is toggled off by default. The second enhancement allows you to limit the edges that will be extended

when you use target faces. Now when you click OK in the dialog box, Abaqus/CAE highlights only those

edges from your selection that would intersect with the target faces and gives you the option to extend these

edges instead of your original selection. You can accept the new selection, extend your original selection

(edges or all free edges if you selected faces), or cancel the procedure. This enhancement allows you to use

faster selection methods while still extending only the intersecting edges.

The Blend Faces procedure has been enhanced so that you now select edges for the first and second

sides of the blend before the dialog box is displayed.
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Abaqus/CAE Usage:
Part module:

Tools→Geometry Edit: Face: Offset, Extend, or Blend

References:

Abaqus/CAE User’s Manual

• “Offset faces,” Section 68.6.7, in the online HTML version of this manual

• “Extend faces,” Section 68.6.8, in the online HTML version of this manual

• “Blend faces,” Section 68.6.9, in the online HTML version of this manual

4.4 Creating a wire-from-edge feature

Product: Abaqus/CAE

Benefits: You can now convert shell or solid part edges into wires.

Description: When you select edges to create a wire-from-edge feature, Abaqus/CAE removes the adjoining

faces and creates a wire feature to replace all edges of the removed faces. In addition, Abaqus/CAEmakes any

other changes necessary to retain the validity of the remaining geometry, such as converting solids to shells.

For example, if you select two disconnected edges from a solid box, the resulting model contains two

shell faces and a wire feature that completes the original shape of the box, as shown Figure 4–4. Each of the

selected edges was associated with two faces, so Abaqus/CAE removes those faces and converts the solid to

a shell. The selected edges, and all the other edges that are no longer associated with faces, make up the new

wire feature.

Figure 4–4 Creating wires from the edges of a solid part.
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Abaqus/CAE Usage:
Part module:

Shape→Wire→From Edge

Reference:

Abaqus/CAE User’s Manual

• “Adding a wire-from-edge feature,” Section 11.23.5, in the online HTML version of this manual

4.5 Adding a mirror feature to a part

Product: Abaqus/CAE

Benefits: You can now add a mirror feature to a part. The mirror feature retains the complete feature history

of the part, and you can select any planar face or datum plane as the mirror plane.

Description: The new mirror feature is similar to the existing mirror option available when you copy a part.

However, the mirror feature has three advantages over a copied part:

• You can still edit all the other part features.

• You can select any planar face or datum plane as the mirror plane.

• You can keep or delete the original geometry and any internal boundaries between the original and the

mirror image.

In contrast, copying a part with the mirror option compresses the features so the original features are no longer

available to edit. Using the mirror option while copying a part also allows you to mirror the part only about

the principal planes.

Figure 4–5 shows an original part with the mirror plane highlighted and the resulting mirror features

when the original geometry is kept. The center image is the result with internal boundaries, and the right

image is the result without internal boundaries.

Figure 4–5 Mirror features, with and without internal boundaries.
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Mirror features can be deleted, suppressed, and resumed. Since you create them by making selections from

the viewport, mirror features have no editable parameters.

Abaqus/CAE Usage:
Part module:

Shape→Transform→Mirror

Reference:

Abaqus/CAE User’s Manual

• “Mirroring a part,” Section 11.28, in the online HTML version of this manual

4.6 Diagnostics for modeling errors associated with mass properties

Product: Abaqus/Standard

Benefits: New diagnostics help you to avoid mistakes in specifying inertia properties in a dynamic model.

Description: Abaqus/Standard issues an error message by default if the global mass matrix is singular for

dynamics models with an application-type setting of “transient fidelity.” The global mass matrix is affected

by material densities, concentrated masses and rotary inertias, and nonstructural mass. A singular global

mass matrix is most commonly due to omitting specification of inertia properties. A warning message is also

issued if a density definition is omitted for any materials in a dynamic analysis. Other more subtle causes of a

singular global mass matrix include the density being zero for certain values of temperature or field variables

and unconstrained degrees of freedom at massless nodes that are connected to other nodes by constraints.

References:

Abaqus Analysis User’s Manual

• “Implicit dynamic analysis using direct integration,” Section 6.3.2

Abaqus Keywords Reference Manual

• *DYNAMIC

4.7 Thickness and material orientation distributions for membrane
elements and sections

Products: Abaqus/Standard Abaqus/CAE

Benefits: Using distributions to specify spatially varying thicknesses and material orientations on membrane

elements greatly simplifies the modeling process and improves performance for models with a significant

amount of element property variation.
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Description: In Abaqus/Standard you can now define material orientations and thickness for membrane

elements using distributions. These enhancements allow you to minimize the number of section definitions

needed for a model that has significant variation of these features, which can lead to performance

improvements during pre- and postprocessing.

In Abaqus/CAE you can now use an analytical field or an element-based discrete field to define the

spatially varying membrane thickness, as shown in Figure 4–6.

Figure 4–6 Using element distributions for membrane thickness.

Abaqus/CAE Usage:
Property module:

Section→Create; Category: Shell; Type: Membrane
Membrane thickness: Element distribution

References:

Abaqus Analysis User’s Manual

• “Orientations,” Section 2.2.5

• “Distribution definition,” Section 2.7.1

• “Membrane elements,” Section 26.1.1

Abaqus/CAE User’s Manual

• “Creating membrane sections,” Section 12.12.7, in the online HTML version of this manual
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Abaqus Keywords Reference Manual

• *DISTRIBUTION

• *MEMBRANE SECTION

Abaqus Verification Manual

• “Spatially varying element properties,” Section 5.1.3

4.8 Composite layer thickness distribution for shell elements

Product: Abaqus/Explicit

Benefits: Using a distribution to specify spatially varying composite layer thicknesses on shell elements

greatly simplifies the modeling process and improves performance for models with a significant amount of

element property variation.

Description: In Abaqus/Explicit you can define composite layer thicknesses for shell elements using a

distribution. This enhancement allows you to minimize the number of section definitions needed for a model

that has significant variation of these features, which can lead to model simplification and performance

improvements.

References:

Abaqus Analysis User’s Manual

• “Distribution definition,” Section 2.7.1

• “Using a shell section integrated during the analysis to define the section behavior,” Section 26.6.5

• “Using a general shell section to define the section behavior,” Section 26.6.6

Abaqus Keywords Reference Manual

• *DISTRIBUTION

• *SHELL GENERAL SECTION

• *SHELL SECTION

Abaqus Verification Manual

• “Spatially varying element properties,” Section 5.1.3
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5. Model import and export

This chapter discusses features related to importing and exporting models to or from Abaqus/CAE. It provides

an overview of the following enhancements:

• “Exporting models in OBJ format,” Section 5.1

• “Improved import and translation of membrane data from Nastran models,” Section 5.2

5.1 Exporting models in OBJ format

Product: Abaqus/CAE

Benefits: Wavefront OBJ is an open file format for geometry definition and visualization that is supported

by many three-dimensional graphics applications. You can now export geometry and mesh data from an

Abaqus/CAEmodel database to OBJ format, which enables you to display your Abaqus/CAE data in a variety

of CAD and visualization programs.

Description: Abaqus/CAE now supports export of model data in OBJ format. When you export data from

the Visualization module, Abaqus/CAE exports only mesh data to the OBJ-format file. If you export data from

any other module, Abaqus/CAE exports mesh data if the mesh is displayed in the current viewport; otherwise,

geometry data are exported.

Export of data from the Visualization module is also sensitive to the current step and frame. If you

display an undeformed plot in the viewport, Abaqus/CAE exports undeformed data to the OBJ-format file;

if you display a deformed plot, Abaqus/CAE exports deformed data for the current step and frame to the

OBJ-format file.

Abaqus/CAE Usage:
All modules:

File→Export→OBJ

Reference:

Abaqus/CAE User’s Manual

• “Exporting viewport data to an OBJ-format file,” Section 10.9.6, in the online HTML version of this

manual

5.2 Improved import and translation of membrane data from Nastran
models

Products: Abaqus/Standard Abaqus/Explicit Abaqus/CAE
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Benefits: You can now translate a Nastran model containing many different membrane properties to an

Abaqus model that contains a single membrane section.

Description: The abaqus fromNastran execution procedure and the Import Nastran Input File
dialog box now provide translation and import for Nastran membrane data. You can control the section

consolidation of membrane data using the same options that control the section consolidation of section data.

The distribution parameter settings for the execution procedure and the Section consolidation options in

Abaqus/CAE determine whether Abaqus creates a membrane section for each Nastran PSHELL or PCOMP

property ID, creates sections for all homogeneous elements that reference the same material, or creates a

separate membrane section for each combination of thickness or orientation in the Nastran input file.

Abaqus/CAE Usage:
All modules:

File→Import→Model: File Format: Nastran: Section consolidation options

References:

Abaqus Analysis User’s Manual

• “Translating Nastran bulk data files to Abaqus input files,” Section 3.2.21

Abaqus/CAE User’s Manual

• “Importing a model from a Nastran input file,” Section 10.5.4
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6. Analysis procedures

This chapter discusses features related to defining an analysis. It provides an overview of the following

enhancements:

• “Change in default element stable time estimation for three-dimensional continuum elements,”

Section 6.1

• “Continued enhancements to the XFEM-based crack propagation capability,” Section 6.2

• “New RNG k–epsilon turbulence model for fluid dynamic analysis,” Section 6.3

• “Enhancements to coupled structural-acoustic analysis,” Section 6.4

• “AMS eigensolver performance improvement,” Section 6.5

• “Enhanced iterative solver capability to handle dense linear constraints,” Section 6.6

• “Defining a spectrum using values of S as a function of frequency and damping in Abaqus/CAE,”

Section 6.7

• “Creating a spectrum from a user-specified amplitude in Abaqus/Standard,” Section 6.8

• “New modal and directional summation methods for response spectrum analysis,” Section 6.9

• “Using uncoupled eigenmodes to generate a coupled acoustic-structural substructure,” Section 6.10

6.1 Change in default element stable time estimation for
three-dimensional continuum elements

Product: Abaqus/Explicit

Benefits: The default element stable time estimation now provides a larger element stable time increment.

For analyses using variable mass scaling, less total mass will need to be added to achieve the given stable

time increment.

Description: By default, Abaqus/Explicit will now use the “improved” element time estimation method to

calculate the element stable time increment for three-dimensional elements. This “improved” element time

estimation method usually results in a larger element stable time increment than a more traditional method.

References:

Abaqus Analysis User’s Manual

• “Explicit dynamic analysis,” Section 6.3.3

• “Fully coupled thermal-stress analysis,” Section 6.5.4
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Abaqus Keywords Reference Manual

• *DYNAMIC

• *DYNAMIC TEMPERATURE-DISPLACEMENT

6.2 Continued enhancements to the XFEM-based crack propagation
capability

Product: Abaqus/Standard

Benefits: The extended finite element method (XFEM) allows you to model discontinuities, such as cracks,

along an arbitrary, solution-dependent path during an analysis. A user-defined damage initiation criterion can

now be used within the framework of XFEM. This capability is very useful to accurately predict the durability

and damage tolerance of composite structures and the bone fracture with complex failure mechanisms. A

low-cycle fatigue analysis can now be simulated with XFEM for a structure subjected to cyclic loading by

using the direct cyclic approach.

Description: XFEM allows you to model crack growth without remeshing the crack surfaces since it does

not require the mesh to match the geometry of the crack. A user-defined damage initiation criterion is now

supported. User subroutine UDMGINI provides a very general capability for implementing a user-defined

damage initiation criterion. You can specify more than one failure mechanism in an enriched element, with

the most severe one governing the actual failure.

The XFEM capability can be used to simulate a discrete crack growth along an arbitrary path subjected to

a sub-critical cyclic loading based on the principles of linear elastic fracture mechanics (LEFM) in a low-cycle

fatigue analysis using the direct cyclic approach. The fracture energy release rates at the crack tips in the

enriched elements are calculated based on the modified VCCT technique. The onset and crack growth are

characterized by using the Paris law, which relates the relative fracture energy release rates to crack growth

rates. A low-cycle fatigue step can be the only step, can follow a general static step, or can be followed by a

general static step. Multiple low-cycle fatigue analysis steps can be included in a single analysis. If a fatigue

analysis is performed in a model without a pre-existing crack, a static step followed by the fatigue step can

be used to nucleate a crack.

References:

Abaqus Analysis User’s Manual

• “Low-cycle fatigue analysis using the direct cyclic approach,” Section 6.2.7

• “Modeling discontinuities as an enriched feature using the extended finite element method,”

Section 10.6.1
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Abaqus Keywords Reference Manual

• *DAMAGE EVOLUTION

• *DAMAGE INITIATION

• *DIRECT CYCLIC

• *ENRICHMENT

• *FRACTURE CRITERION

Abaqus User Subroutines Reference Manual

• “UDMGINI,” Section 1.1.23

Abaqus Benchmarks Manual

• “Crack propagation of a single-edge notch simulated using XFEM,” Section 1.19.1

• “Crack propagation in a plate with a hole simulated using XFEM,” Section 1.19.2

6.3 New RNG k–epsilon turbulence model for fluid dynamic analysis

Products: Abaqus/CFD Abaqus/CAE

Benefits: The RNG k– model is a two-equation model based on renormalization group theory that produces

more accurate results than the standard k– model for flow problems where separation and recirculation occur.

Description: The RNG k– model is a two-equation model based on renormalization group theory that

accounts for the effects of small scales of motion in contrast to the standard k– model that bases its turbulent

viscosity on a single length scale. The RNG k– model attempts to account for the contribution of multiple

scales to the dissipation rate. The RNG k– model in Abaqus/CFD is implemented using wall functions that

rely on an advanced normal-distance level-set function to accurately locate the near-wall region in complex

geometry. As a two-equation model, the incremental computational cost increase is quite small relative to the

Spalart-Allmaras model.

Abaqus/CAE Usage:
Step module:

Step→Create: General: Flow; Turbulence tabbed page: k-epsilon renormalization group (RNG)

References:

Abaqus Analysis User’s Manual

• “Incompressible fluid dynamic analysis,” Section 6.6.2

Abaqus/CAE User’s Manual

• “Configuring a flow procedure” in “Configuring general analysis procedures,” Section 14.11.1, in the

online HTML version of this manual
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6.4 Enhancements to coupled structural-acoustic analysis

Product: Abaqus/Standard

Benefits: Enhanced functionality in coupled structural-acoustic subspace-based steady-state dynamic

analysis is available.

Description: The following features can be included in coupled structural-acoustic steady-state dynamic

analysis that uses the high-performance SIM architecture:

• You can specify the fluid flow velocity as a predefined field for an acoustic domain.

• You can use infinite acoustic elements to define an unbounded domain.

• You can define the volumetric drag coefficient for the acoustic medium as a function of frequency.

• You can select modes that will be used in a modal procedure.

References:

Abaqus Analysis User’s Manual

• “Natural frequency extraction,” Section 6.3.5

• “Subspace-based steady-state dynamic analysis,” Section 6.3.9

• “Acoustic, shock, and coupled acoustic-structural analysis,” Section 6.10.1

Abaqus Keywords Reference Manual

• *ACOUSTIC FLOW VELOCITY

• *ACOUSTIC MEDIUM

• *FREQUENCY

• *SELECT EIGENMODES

• *STEADY STATE DYNAMICS

6.5 AMS eigensolver performance improvement

Products: Abaqus/Standard Abaqus/AMS

Benefits: New scalable thread-parallel execution capability of the AMS eigensolver significantly improves

the performance of frequency extraction analyses.

Description: Scalable thread-parallel execution of the AMS eigensolver delivers significant performance

improvement on shared memory computers and on a single node of a computer cluster.

Table 6–1 illustrates the improved performance of the AMS eigensolver on a system with Intel Nehalem

processors for two industrial models: Model 1 is a 4.3 million degree-of-freedom automotive powertrain

model with a large selective recovery node set and damping projection, and Model 2 is a 9.2 million degree-
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of-freedom automotive vehicle model with a large selective recovery node set. The wall-clock times in the

table indicate the total elapsed times for the frequency extraction step using the AMS eigensolver.

Table 6–1 AMS performance improvement due to a new scalable

thread-parallel execution capability.

Abaqus 6.10 (1-core) Abaqus 6.10-EF (4-core)

Model
Degrees of
Freedom
(Millions) Number of

Modes
Wall Clock

Time (h:mm)
Number of

Modes
Wall Clock Time

(h:mm)

Model 1 4.3 1709 1:02 1710 0:29

Model 2 9.2 4208 2:00 4210 1:03

Large-scale models specifying full recovery of eigenmodes may require a considerable amount of

physical memory to avoid extra I/O operations, which may lead to a degradation of parallel scaling. Due

to this enhancement and the approximate nature of the AMS technology, it is possible to observe slight

differences in the number of eigenmodes extracted by AMS in Abaqus 6.10-EF versus Abaqus 6.10. These

differences are expected since AMS eigenmodes close to the user-specified maximum frequency are generally

less accurate and more sensitive to perturbations (e.g., changes in the order of the system of equations).

However, the results of subsequent modal dynamic procedures are very close to the results in Abaqus 6.10

and previous releases if an appropriate number of modes are used to construct the projection basis.

References:

Abaqus Analysis User’s Manual

• “Natural frequency extraction,” Section 6.3.5

Abaqus Keywords Reference Manual

• *FREQUENCY

6.6 Enhanced iterative solver capability to handle dense linear
constraints

Product: Abaqus/Standard

Benefits: The iterative solver algorithm offers improved handling of dense linear constraints to better

achieve convergence.

Description: The iterative solver can now achieve better convergence for models that include dense linear

constraint equations (such as multi-point constraints, surface-based tie constraints, kinematic couplings, etc.)
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that eliminate a large number of slave degrees of freedom per master degree of freedom and/or eliminate some

slave degrees of freedom in favor of a large number of master degrees of freedom.

Previously in Abaqus 6.10, dense linear constraints would often lead to non-convergence of the iterative

solver. In the current release, the iterative solver has a new treatment for dense linear constraints to better

achieve convergence.

If a model contains a large amount of dense constraints, performance may be reduced. See “Iterative

linear equation solver,” Section 6.1.5 of the Abaqus Analysis User’s Manual, for more details.

Reference:

Abaqus Analysis User’s Manual

• “Iterative linear equation solver,” Section 6.1.5

6.7 Defining a spectrum using values of S as a function of frequency
and damping in Abaqus/CAE

Products: Abaqus/Standard Abaqus/CAE

Benefits: The ability to define a spectrum in Abaqus/CAE increases the coverage of Abaqus product

functionality.

Description: When performing a response spectrum analysis, you must first convert the given dynamic

event into a spectrum. In Abaqus/CAE you can now use the Amplitude toolset to define a spectrum by

specifying the magnitude of the spectrum at all frequencies at each damping value. You can then use the

spectrum amplitude in a response spectrum analysis. Figure 6–1 shows how you can read the data for the

spectrum amplitude from a file.

Abaqus/CAE Usage:
Step module, Interaction module, or Load module:

Tools→Amplitude→Create: Type: Spectrum: define spectrum

Step module:

Step→Create: Linear perturbation: Response spectrum; Use response spectrum: select spectrum

References:

Abaqus Analysis User’s Manual

• “Response spectrum analysis,” Section 6.3.10

Abaqus/CAE User’s Manual

• “Defining a spectrum,” Section 56.11, in the online HTML version of this manual
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Figure 6–1 Reading spectrum data from a file.

6.8 Creating a spectrum from a user-specified amplitude in
Abaqus/Standard

Product: Abaqus/Standard

Benefits: The ability to create a spectrum from a user-specified amplitude that describes a dynamic event

simplifies the conversion process.

Description: When performing a response spectrum analysis, you must first convert the dynamic event into

a spectrum. Abaqus/Standard allows you to create a spectrum automatically from a given dynamic event

that is supplied in the form of a user-defined time domain amplitude record. You can build a displacement,

velocity, or acceleration spectrum for a number of provided damping values. The spectrum that you create

can be used in a subsequent response spectrum analysis or it can be written to an external file for future use.

References:

Abaqus Analysis User’s Manual

• “Response spectrum analysis,” Section 6.3.10
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Abaqus Keywords Reference Manual

• *SPECTRUM

6.9 New modal and directional summation methods for response
spectrum analysis

Products: Abaqus/Standard Abaqus/CAE

Benefits: The new modal and directional summation methods for response spectrum analysis comply with

the latest regulations and conform to the ASCE 4–98 standard for Seismic Analysis of Safety-Related Nuclear

Structures and Commentary.

Description: Two new modal summation methods for response spectrum analysis are now available: the

double sum combination (DSC) method and the grouping (GRP) method. The double sum combination

method is the first attempt to evaluate modal correlation based on random vibration theory. The grouping

method improves the response estimation for structures with closely spaced eigenvalues.

Two new directional summation methods for response spectrum analysis are now available: the 40%

(R40) method and the 30% (R30) method. These methods use the rules recommended in the ASCE 4–98

standard to combine the response for all possible combinations of the three components, including variations

in sign (plus/minus), assuming that when the maximum response from one component occurs, the response

from the other two components is 40% (or 30%) of their maximum value.

Abaqus/CAE Usage:
Step module:

Step→Create: Linear perturbation: Response spectrum;

Excitations: Multiple direction thirty percent rule or Multiple direction forty percent rule;
Summations: Double sum combination or Grouping method

References:

Abaqus Analysis User’s Manual

• “Response spectrum analysis,” Section 6.3.10

Abaqus/CAE User’s Manual

• “Configuring a response spectrum procedure” in “Configuring linear perturbation analysis procedures,”

Section 14.11.2, in the online HTML version of this manual

Abaqus Keywords Reference Manual

• *RESPONSE SPECTRUM
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Abaqus Theory Manual

• “Response spectrum analysis,” Section 2.5.6

6.10 Using uncoupled eigenmodes to generate a coupled
acoustic-structural substructure

Product: Abaqus/Standard

Benefits: You can select uncoupled eigenmodes to generate a coupled acoustic-structural substructure.

This enhancement allows you to take advantage of the benefits offered by the AMS eigensolver to generate

substructures from large NVH models.

Description: Abaqus/Standard can now use uncoupled eigenmodes, generated from the SIM-based Lanczos

or AMS eigensolver, to generate a coupled acoustic-structural substructure. In this case the effect of acoustic-

structural coupling is included during the substructure generation.

References:

Abaqus Analysis User’s Manual

• “Defining substructures,” Section 10.1.2

Abaqus Keywords Reference Manual

• *FREQUENCY

• *SELECT EIGENMODES

• *SUBSTRUCTURE GENERATE
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7. Materials

This chapter discusses new material models or changes to existing material models. It provides an overview

of the following enhancement:

• “Material calibration,” Section 7.1

7.1 Material calibration

Product: Abaqus/CAE

Benefits: You can now calibrate an isotropic elastic-plastic material model in Abaqus using material test

data. This enhancement enables you to import material test data into Abaqus/CAE, process the data to improve

their suitability for material modeling, and derive isotropic elastic and plastic material behaviors from the data.

Description: Material calibration is the process of deriving Abaqus material behaviors from sets of material

test data. You can create material calibrations in three general steps:

• Create data sets by importing text files of material test data into Abaqus/CAE. You can customize these

data by adding, deleting, or modifying individual rows. In addition, you can label the columns in a data

set with quantity types to describe the data: material calibration data sets can be labeled as stress/strain,

force/displacement, or axial strain/transverse strain.

• Process the contents of a data set using filters and tools to make the data more suitable for use in material

modeling. The processing options enable you to scale the data along either axis, to smooth the curve of

the data, and to truncate data points above a specified value along the X-axis. You can also convert a data

set between nominal and true forms.

• Define calibration behaviors to derive elasticity- and plasticity-related parameters from the data. You

can define isotropic elastic calibration behaviors to define the Young’s modulus and Poisson’s ratio from

material data, or you can define an isotropic elastic-plastic calibration behavior to define the elastic

behavior as well as the yield point and a set of data points defining material plasticity.

Once you complete the selected calibration behaviors for your material test data, Abaqus/CAE adds

the new material behaviors to your selected material definition.

As you import, process, and extract calibration behaviors from material data, Abaqus/CAE plots the

selected material data in the viewport. Figure 7–1 shows an isotropic elastic-plastic calibration in progress;

the elastic and plastic material definitions are specified in the Elastic Plastic Isotropic dialog box, and they

are also plotted in the viewport.
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Figure 7–1 Defining an isotropic elastic-plastic material calibration behavior.

Abaqus/CAE Usage:
Property module:

Model Tree: Calibrations container

Reference:

Abaqus/CAE User’s Manual

• “Creating material calibrations,” Section 12.16, in the online HTML version of this manual
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8. Elements

This chapter discusses elements available in Abaqus. It provides an overview of the following enhancements:

• “New linear pore pressure elements,” Section 8.1

• “Tapered beams and improved mass formulation,” Section 8.2

• “New 6-node triangular prism for fluid flow problems,” Section 8.3

8.1 New linear pore pressure elements

Products: Abaqus/Standard Abaqus/CAE

Benefits: The pore pressure element library in Abaqus/Standard now includes both linear tetrahedral

(C3D4P) and linear wedge (C3D6P) elements. These elements add modeling flexibility for coupled pore

pressure-displacement analyses.

Description: Pore pressure elements are provided in Abaqus/Standard for modeling fully or partially

saturated fluid flow through a deforming porous medium. These two new elements support all of the

loadings, material behaviors, and contact interactions supported by existing pore pressure elements.

Abaqus/CAE Usage:
Mesh module:

Mesh→Element Type: Family: Pore Fluid/Stress

References:

Abaqus Analysis User’s Manual

• “Coupled pore fluid diffusion and stress analysis,” Section 6.8.1

• “Three-dimensional solid element library,” Section 25.1.4

Abaqus/CAE User’s Manual

• “Element type assignment,” Section 17.5.3

Abaqus Example Problems Manual

• “Calculation of phreatic surface in an earth dam,” Section 10.1.2

Abaqus Benchmarks Manual

• “Partially saturated flow in a porous medium,” Section 1.9.1

• “Demand wettability of a porous medium: coupled analysis,” Section 1.9.2

• “Wicking in a partially saturated porous medium,” Section 1.9.3

• “Desaturation in a column of porous material,” Section 1.9.4
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Abaqus Verification Manual

• “Continuum pore pressure elements,” Section 1.4.7

Abaqus Theory Manual

• “Effective stress principle for porous media,” Section 2.8.1

8.2 Tapered beams and improved mass formulation

Products: Abaqus/Standard Abaqus/CAE

Benefits: You can now define Timoshenko beams with linearly tapered cross-sections in Abaqus/Standard

and in Abaqus/CAE. You can also use an improved mass formulation for linear Timoshenko beams based on

cubic deflections.

Description: Timoshenko beams in Abaqus/Standard now support linearly tapered general beam sections

and standard library sections. This enhancement enables you to create tapered beam geometry in your model

and to import tapered general beam sections from third-party applications such as Nastran.

A new improvedmass formulation for linear Timoshenko beams is also available. The newmassmatrix is

based on cubic interpolations and provides much better estimates of the frequency response of coarse meshes,

especially when used in conjunction with the automatic calculation of the slenderness correction factor based

on the section’s elastic properties.

Abaqus/CAE Usage:
Property module:

Beam section editor: Section integration: Before analysis: Beam shape along length: Tapered; and
Stiffness tabbed page: Use consistent mass matrix formulation

References:

Abaqus Analysis User’s Manual

• “Choosing a beam element,” Section 26.3.3

• “Defining linear section behavior for tapered cross-sections in Abaqus/Standard” in “Using a general

beam section to define the section behavior,” Section 26.3.7

Abaqus/CAE User’s Manual

• “Creating beam sections,” Section 12.12.10, in the online HTML version of this manual

Abaqus Keywords Reference Manual

• *BEAM GENERAL SECTION

• *BEAM SECTION
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8.3 New 6-node triangular prism for fluid flow problems

Products: Abaqus/CFD Abaqus/CAE

Benefits: The fluid flow elements in the Abaqus/CFD element library now include the triangular prism

(FC3D6) element. This element adds modeling flexibility for fluid flow analyses.

Description: Fluid flow elements are provided in Abaqus/CFD for modeling the fluid domain. The new

FC3D6 element supports all of the loadings, material behaviors, and boundary conditions supported by the

existing fluid flow elements.

Abaqus/CAE Usage:
Mesh module:

Mesh→Element Type

References:

Abaqus Analysis User’s Manual

• “Fluid (continuum) elements,” Section 25.2.1

• “Fluid element library,” Section 25.2.2

Abaqus/CAE User’s Manual

• “Assigning Abaqus element types,” Section 17.5
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9. Prescribed conditions

This chapter discusses loads, boundary conditions, and predefined fields. It provides an overview of the

following enhancements:

• “Three-dimensional pressure penetration loading,” Section 9.1

• “Changing the coordinate system for symmetry boundary conditions,” Section 9.2

• “Total force distribution option for pressure loads,” Section 9.3

• “Specifying the source and target regions for temperature mapping,” Section 9.4

• “Explicit dynamics analysis using Abaqus/Aqua,” Section 9.5

9.1 Three-dimensional pressure penetration loading

Products: Abaqus/Standard Abaqus/CAE

Benefits: Pressure penetration loading is now available for three-dimensional models.

Description: Pressure penetration loading can now be applied to the contact pair surfaces defined by using

solid, cylindrical solid, shell, continuum shell, membrane, and rigid elements in three dimensions. It can also

be applied to an analytical three-dimensional rigid surface when the surface is defined as the master surface

of a contact pair. Two important enhancements are made for planar and axisymmetric models as well as for

three-dimensional models:

• Pressure penetration loading can now be used with any contact formulation within the contact pair

framework.

• MPI-based parallelization of element operations is supported.

Figure 9–1 shows the pressure penetration between two three-dimensional rings started from the bottom

side at the outside corner of the contact surfaces.

Abaqus/CAE Usage:
Interaction module:

Interaction→Create: Pressure penetration

References:

Abaqus Analysis User’s Manual

• “Pressure penetration loading,” Section 33.1.7

Abaqus/CAE User’s Manual

• “Defining pressure penetration,” Section 15.13.13, in the online HTML version of this manual
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Figure 9–1 Pressure penetration between two bodies defined using CCL12 elements.

Abaqus Keywords Reference Manual

• *PRESSURE PENETRATION

Abaqus Example Problems Manual

• “Pressure penetration analysis of an air duct kiss seal,” Section 1.1.16

Abaqus Verification Manual

• “Surface-based pressure penetration,” Section 1.3.42

Abaqus Theory Manual

• “Pressure penetration loading with surface-based contact,” Section 6.4.1

9.2 Changing the coordinate system for symmetry boundary
conditions

Product: Abaqus/CAE
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Benefits: You can now change the coordinate system in which you apply a symmetry, antisymmetry, or

encastre boundary condition. This enhancement provides a finer level of control when defining these types of

boundary conditions.

Description: By default, the global coordinate system is used when defining any boundary condition. For

a symmetry/antisymmetry/encastre boundary condition, the Edit Boundary Condition dialog box now

includes a button that lets you do either of the following:

• Select an existing datum coordinate system in the viewport.

• Select an existing datum coordinate system by name.

Figure 9–2 shows the new edit button, available for the CSYS option.

Figure 9–2 Changing the coordinate system for a symmetry boundary condition.

Abaqus/CAE Usage:
Load module:

Create Boundary Condition; Category: Mechanical; Type: Symmetry/Antisymmetry/Encastre;
CSYS: select other coordinate system
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Reference:

Abaqus/CAE User’s Manual

• “Defining a symmetry/antisymmetry/encastre boundary condition,” Section 16.10.1, in the online HTML

version of this manual

9.3 Total force distribution option for pressure loads

Product: Abaqus/CAE

Benefits: When defining pressure loads, you can choose the new total force option for the load distribution.

This allows you to simply enter the total magnitude of pressure applied over the surface. In previous releases,

using the uniform distribution option, it was necessary to query the faces of the surface to find the total area

and then divide the total force by the surface area. With the new total force option, you can simply enter the

total magnitude of pressure applied over the entire surface.

Description: When modeling a pressure load, you usually know the total force that will be applied to a face

or surface of the model. In previous releases of Abaqus/CAE, this number had to be divided by the surface

area before entering it into the Magnitude field of the Edit Load dialog box (using the existing Uniform
option for Distribution). Now, with the Total Force option (shown in Figure 9–3) you can directly enter the

total magnitude of the pressure.

Abaqus/CAE Usage:
Load module:

Load→Create; Category: Mechanical; Type: Pressure; select surfaces; Distribution: Total Force

Reference:

Abaqus/CAE User’s Manual

• “Defining a pressure load,” Section 16.9.3, in the online HTML version of this manual

9.4 Specifying the source and target regions for temperature mapping

Products: Abaqus/Standard Abaqus/Explicit

Benefits: When temperature fields are interpolated from a previous analysis, you can now specify the source

region from where the temperatures are read and the target region onto where the temperatures are mapped.

This new feature eliminates the ambiguity in temperature assignment for cases in which free surfaces in a heat

transfer analysis are very close or touching.

Description: When mapping prior analysis temperatures to a node in a current analysis, the general

interpolation function searches for a parent element from the previous analysis that encloses or is the closest
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Figure 9–3 Total force distribution option for pressure loads.

to the node. In a heat transfer analysis, temperatures may vary significantly on two surfaces that are close or

touching but on separate parts. In such a case, the parent element might be found in either of the adjacent

parts, resulting in an ambiguous temperature definition for a node on the surfaces. You can now eliminate

this ambiguity by specifying the source and target interpolation regions. The source region refers to the heat

transfer analysis and is specified by an element set. The target region refers to the current analysis and is

specified by a node set.

References:

Abaqus Analysis User’s Manual

• “Initial conditions in Abaqus/Standard and Abaqus/Explicit,” Section 30.2.1

• “Predefined fields,” Section 30.6.1

Abaqus Keywords Reference Manual

• *INITIAL CONDITIONS

• *TEMPERATURE
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9.5 Explicit dynamics analysis using Abaqus/Aqua

Products: Abaqus/Explicit Abaqus/Aqua

Benefits: Abaqus/Aqua, which previously could be used only with Abaqus/Standard, is now available with

Abaqus/Explicit.

Description: In the case of structures submerged in a fluid field, such as offshore pipelines used in the

oil and natural gas industries, appropriate fluid-based loads can be applied to simulate the dynamics of such

structures. You can define the fluid field consisting of steady currents and gravitational waves and identify the

model that is potentially submerged in the fluid. Abaqus computes the appropriate buoyancy and drag loads

(transverse drag, tangential drag, wind drag, and inertial loads) based on that fluid field. Similarly, you can

define a wind field and identify the exposed structure. Abaqus computes the appropriate drag loads based on

that wind field.

Buoyancy and drag loads (transverse drag, tangential drag, wind drag and inertial loads) can be applied

on linear beam and pipe elements, either in the form of distributed or concentrated loads. In Abaqus/Explicit

the gravitational waves formulation is limited to the fifth-order Stokes wave.

References:

Abaqus Analysis User’s Manual

• “Abaqus/Aqua analysis,” Section 6.11.1

Abaqus Keywords Reference Manual

• *AQUA

• *CLOAD

• *DLOAD

• *WAVE

• *WIND
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10. Constraints

This chapter discusses kinematic constraints. It provides an overview of the following enhancements:

• “Automatic shell-to-solid coupling constraints,” Section 10.1

• “Improvement to coupling definition,” Section 10.2

10.1 Automatic shell-to-solid coupling constraints

Product: Abaqus/CAE

Benefits: Abaqus/CAE automatically creates shell-to-solid coupling constraints between the shell and solid

sections within a single part instance.

Description: When the model of a single part contains both shell and solid sections, such as when a

midsurface shell section is created within a solid part, Abaqus/CAE now automatically creates shell-to-solid

coupling constraints so that the shell portions of the model follow the motion of the adjoining solid sections.

Automatic shell-to-solid coupling constraints are created only in sections within the same part instance,

and the sections being constrained must be nearly perpendicular. You must manually create shell-to-solid

coupling constraints between separate part instances.

References:

Abaqus/CAE User’s Manual

• “Defining shell-to-solid coupling constraints,” Section 15.15.6, in the online HTML version of this

manual

• “Understanding midsurface modeling,” Section 34.1

10.2 Improvement to coupling definition

Products: Abaqus/Standard Abaqus/Explicit

Benefits: You can now specify multiple coupling constraints on a surface via a single coupling definition

instead of multiple definitions. Weights for a distributing type coupling are now the same as those formed

using fasteners.

Description: It is now easy to specify multiple coupling definitions on a given surface just by including

all the reference nodes in a single reference node set instead of defining separate coupling definitions. The

weights for cloud nodes of a distributing type coupling are identical to those formed using fasteners.
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Reference:

Abaqus Keywords Reference Manual

• “*COUPLING,” Section 3.79
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11. Interactions

This chapter discusses features related to contact and interaction modeling. It provides an overview of the

following enhancements:

• “Contact stress output improvements,” Section 11.1

• “Penalty stiffness for contact involving gaskets,” Section 11.2

• “Edge-to-edge general contact enhancement,” Section 11.3

11.1 Contact stress output improvements

Product: Abaqus/Standard

Benefits: Contact stress output is more accurate for second-order surfaces.

Description: Contact pressure output (CPRESS) and contact shear stress output CSHEAR1 and CSHEAR2
to the output database (.odb) file have been made more accurate and less noisy for second-order surfaces.

The improvements tend to be most noticeable in regions with significant variation of contact stress over

individual surface facets, which commonly occurs near the perimeter of an active contact region. Figure 11–1

and Figure 11–2 show two examples involving quadratic tetrahedral elements (element type C3D10) in

which contact pressure noise has been reduced across versions. Adequate mesh refinement remains necessary

for accurate predictions with finite element methods. As in previous releases, contact stress accuracy is

generally more accurate with the surface-to-surface contact formulation than with the node-to-surface contact

formulation. Results are not affected by this enhancement for the following surface types: surfaces based on

linear element types, surfaces based on modified tetrahedral or triangular elements, and node-based surfaces.

References:

Abaqus Analysis User’s Manual

• “Surface output in Abaqus/Standard and Abaqus/Explicit” in “Output to the output database,”

Section 4.1.3

• “Abaqus/Standard output variable identifiers,” Section 4.2.1

Abaqus Keywords Reference Manual

• *CONTACT OUTPUT

11.2 Penalty stiffness for contact involving gaskets

Product: Abaqus/Standard
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Figure 11–1 Reduced CPRESS solution noise across versions for an initially spherical surface.
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Figure 11–2 Reduced CPRESS solution noise across versions for a coarsely meshed nut.

Benefits: You can now obtain improved accuracy for modeling contact interactions with gasket elements.

Description: The algorithm to automatically assign contact penalty stiffness now accounts for stiffening

of underlying gasket elements upon compression if thickness-direction gasket material behavior is specified

directly. This change will typically result in better resolution of contact conditions for cases in which the

penalty or augmented Lagrangemethods are used to enforce contact constraints at interfaces involving gaskets.

If you have existing models that employ scale factors to adjust the penalty stiffness at such interfaces, these
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scale factors are likely no longer needed and may degrade convergence behavior; you should try removing

these scale factors when using the new stiffness algorithm.

References:

Abaqus Analysis User’s Manual

• “Defining the thickness-direction behavior of the gasket” in “Defining the gasket behavior directly using

a gasket behavior model,” Section 29.6.6

• “Contact constraint enforcement methods in Abaqus/Standard,” Section 34.1.2

Abaqus Keywords Reference Manual

• *GASKET THICKNESS BEHAVIOR

• *SURFACE BEHAVIOR

11.3 Edge-to-edge general contact enhancement

Product: Abaqus/Explicit

Benefits: You can now obtain more efficient and robust edge-to-edge contact interactions in general contact

in Abaqus/Explicit.

Description: Edge-to-edge contact now allows for more local tracking information to be utilized to reduce

the extent of global tracking required. This change will typically result in better edge-to-edge contact

performance in analyses that include extensive edge-to-edge contact interactions. The new algorithm is

active by default for all edge-to-edge contact interactions defined in a model.

References:

Abaqus Analysis User’s Manual

• “Contact controls for general contact in Abaqus/Explicit,” Section 32.4.5

Abaqus Keywords Reference Manual

• *CONTACT CONTROLS ASSIGNMENT
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12. Meshing

This chapter discusses features related to meshing your model. It provides an overview of the following

enhancements:

• “Tetrahedral meshing enhancements,” Section 12.1

• “Mesh stack orientations,” Section 12.2

12.1 Tetrahedral meshing enhancements

Product: Abaqus/CAE

Benefits: Tetrahedral meshing algorithms have been improved to provide more accurate meshing for spline

faces and virtual combined faces. Boundary meshing has also been improved, and Abaqus now uses quadratic

tetrahedral elements by default instead of linear elements in some cases. Transitions from small to large mesh

elements are more gradual than in past releases.

Description: The triangular surface meshing process has been improved to minimize gaps between the

boundary nodes and the geometry prior to generating the tetrahedral mesh. The former process sometimes

resulted in a bumpy mesh for certain curved surfaces if quadratic elements were used, as shown on the left in

Figure 12–1. The image on the right shows the quadratic mesh with the new enhancements.

Figure 12–1 Triangular surface meshes with quadratic elements.

12–1

Abaqus ID:

Printed on:



MESHING

In addition, if you choose tetrahedral meshing instead of hexahedral, hex-dominated, or wedge meshing to

mesh a three-dimensional region, Abaqus now uses quadratic-order tetrahedral elements as the default instead

of linear tetrahedral elements. However, Abaqusmay still use linear tetrahedral elements if nondefault element

types were selected before you chose to use tetrahedral meshing.

The boundary meshing process has been improved to prevent poor boundary elements from causing the

tetrahedral mesh to fail. Figure 12–2 shows a tetrahedral mesh generated in Abaqus 6.10 with an element

error highlighted and the same mesh generated in the current release containing no errors.

Figure 12–2 Poor tetrahedral boundary elements are removed.

Reference:

Abaqus/CAE User’s Manual

• Chapter 17, “The Mesh module”

12.2 Mesh stack orientations

Product: Abaqus/CAE

Benefits: You can now assign amesh stack direction for solid parts that is independent of the sweep direction,

and the cells need not be swept or bottom-up meshed. You can assign a single stack orientation to multiple

cells. In addition, the shell/element normal and beam/truss tangent assignment tools are now available in the

Mesh module.
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Description: Continuum shell, cohesive, cylindrical, and gasket elements all include directional properties

that depend on the stack orientation of the elements. You can now assign a stack direction based on the

orientation of a reference face. If the cells are already meshed, Abaqus/CAE changes the stack direction of

the elements as needed. If there is no mesh or a partial mesh, Abaqus/CAE uses the reference face orientation

to define the stack direction of the elements as you mesh the part. As shown in Figure 12–3, the mesh stack

orientation can be completely separate from the sweep direction for a swept part. The stack orientation shown

by the red arrow, with the top element faces colored brown, is perpendicular to the sweep paths (black arrows)

that could be used for this part.

Figure 12–3 The stack orientation need not follow the sweep direction.

You can assign mesh orientations using the Mesh menu, the tool in the Mesh module toolbox, or

the Assign Stack Direction button located in the Mesh Controls dialog box. You can assign a mesh stack

orientation to solid cells with any element shape except tetrahedral.

The Element Normal and Element Tangent options, previously available only in the Property module,

are also included in the new Mesh→Orientation menu.

Abaqus/CAE Usage:
Mesh module:

Mesh→Orientation→Stack, Normal, Tangent

References:

Abaqus/CAE User’s Manual

• “Assigning shell/membrane normal directions,” Section 12.14.5, in the online HTML version of this

manual

• “Assigning beam/truss tangent directions,” Section 12.14.6, in the online HTML version of this manual

• “Applying a mesh stack orientation,” Section 17.17.8, in the online HTML version of this manual
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13. Output and visualization

This chapter discusses obtaining, postprocessing, and visualizing results from Abaqus analyses. It provides

an overview of the following enhancements:

• “Output database size reduction,” Section 13.1

• “Streamlines,” Section 13.2

• “Displaying constraints in the Visualization module,” Section 13.3

• “Displaying free body nodal forces in symbol plots,” Section 13.4

• “Enhanced query options for probing the model,” Section 13.5

• “Controlling plot state and Field Output toolbar synchronization,” Section 13.6

• “Saving and operating on history output X–Y data simultaneously,” Section 13.7

• “Toolbox button for ply stack plot options,” Section 13.8

13.1 Output database size reduction

Products: Abaqus/Standard Abaqus/Explicit Abaqus/CAE

Benefits: A new scheme was implemented as an option in Abaqus/Standard to reduce the size of the output

database for extrapolation and interpolation of three commonly used output variables: stress components,

Mises equivalent stress, and equivalent pressure stress. In addition, in Abaqus/Standard and Abaqus/Explicit

you can now easily request output on the exterior nodes and elements.

Description: The extrapolation and interpolation schemes were changed in Abaqus/Standard for three

commonly used output variables—stress, Mises equivalent stress, and equivalent pressure stress—to reduce

the size of the output database. In the old scheme extrapolation or interpolation was performed after the

analysis finished and required storage of stresses at integration points. In the new scheme the extrapolation

or interpolation is performed as soon as the results are available during the analysis, and only the results at

the requested locations are written to the output database. The new scheme is invoked automatically when

output is requested for any of the supported variables. In the case of Mises equivalent stress and equivalent

pressure stress the new output variables, MISESONLY and PRESSONLY, must be used. If output variables

MISES and PRESS are used instead, the old scheme is invoked.

In addition, an enhancement was implemented in both Abaqus/Standard and Abaqus/Explicit that allows

you to easily request output on the exterior node and element sets. This option is available only for three-

dimensional models and is particularly useful for visualization of the overall deformation of the model.

Abaqus/CAE Usage:
Step module:

Field output request editor or history output request editor: MISESONLY and PRESSONLY
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References:

Abaqus Analysis User’s Manual

• “Output to the output database,” Section 4.1.3

Abaqus/CAE User’s Manual

• “Defining output requests,” Section 14.12, in the online HTML version of this manual

Abaqus Keywords Reference Manual

• *ELEMENT OUTPUT

• *NODE OUTPUT

13.2 Streamlines

Products: Abaqus/CFD Abaqus/CAE

Benefits: You can now visualize the velocity or vorticity of fluid flow in an Abaqus/CFD analysis using

streamlines, which trace the path tangent to a nodal vector field. This enhancement expands the visualization

capabilities of Abaqus/CAE for fluid-structure interaction analyses.

Description: The new Stream toolset enables you to visualize fluid flow data by placing a “rake” into the

flow. A rake is a line segment or series of line segments with a number of points specified along its length;

Abaqus/CAE traces streamlines to display the flow passing through each point on the rake. Figure 13–1

displays the streamlines that show fluid flow downstream from a twelve-pointed stream rake placed at the

inflow duct of a manifold. You can define the rake you want to use by defining a line segment or by specifying

a path definition. If you want to use a line segment for your stream rake, you can either pick starting and ending

nodes from the viewport or enter the global coordinates for the points you want to use.

The Stream Manager enables you to display or hide multiple stream definitions in the viewport; and for

each stream, you can display flow data upstream from the rake location, downstream from the rake location,

or in both directions.

You can also customize the color and thickness of streamlines in the current viewport. Streamlines can

be displayed with a uniform color or by using a contour spectrum that matches the current primary field output

variable. If you display streamlines with contours, you can choose between a banded contour spectrum or a

continuous spectrum. In addition, you can add arrows to the streamlines that indicate the direction of fluid

flow, and you can increase or decrease the number of arrows to clarify their display.

Streamlines display flow data for the currently selected stream variable, which you can control from the

new Stream Variable tabbed page in the Field Output dialog box. Most flow analyses include both velocity

and vorticity data.
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Figure 13–1 Twelve-pointed stream showing velocity data for a flow analysis through a manifold.

Abaqus/CAE Usage:
Visualization module:

Tools→Stream
Result→Field Output: Stream Variable tabbed page

Reference:

Abaqus/CAE User’s Manual

• Chapter 73, “The Stream toolset”

13.3 Displaying constraints in the Visualization module

Product: Abaqus/CAE

Benefits: Abaqus/CAE now lets you view analysis constraints in the Visualization module, facilitating the

debugging of models with large numbers of constraints.
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Description: You can selectively control the display of model constraints using display groups and the ODB
Display Options dialog box. These controls are useful when debugging models that contain large numbers

of constraints. By turning the display of some constraints on and off, you can more easily examine the results.

The following types of constraints can be individually selected for display:

• tie constraints

• rigid body constraints

• shell-to-solid couplings

• distributing couplings

• kinematic couplings

You must first add the desired constraints to a display group for them to be visible in the viewport. You can

create and edit display groups to include (or exclude) different constraints.

Figure 13–2 shows an example of a kinematic coupling constraint display, and Figure 13–3 shows the

new Constraints tab of the ODB Display Options dialog box.

Figure 13–2 Spider lines representing a kinematic coupling constraint in the viewport.
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Figure 13–3 Enabling/disabling display of constraints.

Abaqus/CAE Usage:
Visualization module:

View→ODB Display Options; Constraints tab

Tools→Display Group→Create

References:

Abaqus/CAE User’s Manual

• “Controlling the display of constraints in the Visualization module,” Section 54.11

• “Creating or editing a display group,” Section 77.2.1, in the online HTML version of this manual
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13.4 Displaying free body nodal forces in symbol plots

Product: Abaqus/CAE

Benefits: You can now create a symbol plot that displays nodal forces as free body vectors that show force

and moment distributions across sections of a model. This enhancement enables you to visualize individual

vectors on nodes that vector sum to the total free body vector. The new symbol plot functionality complements

the existing free body cut options, which allow you to obtain the forces and moments at a location in the part

or along a view cut.

Description: Symbol plots in Abaqus/CAE now support the display of free body nodal forces. Figure 13–4

shows a model in which several nodes have an imbalance of forces or moments due to an applied load; the

symbol plot displays free body vectors to identify these nodes. The figure also shows the Field Output dialog
box with the new FREEBODY symbol variable selected.

Figure 13–4 Free body nodal forces displayed in a symbol plot.

The symbol plot displays free body vectors at each node that has a nonzero force summation. The total forces

for the entire part always equal zero.
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The output database you select must include results from output variable NFORC. Abaqus/CAE

calculates the vectors for a symbol plot of free body nodal forces using the contents of the current display

group.

Symbol plots of free body nodal forces can be customized using the same vector display options that are

available for all other symbol plots: you can adjust the vector arrow color, size, style, and density; and you

can display or hide the force or moment values next to each free body vector. In addition, you can still display

free body data on a view cut while you are working with a symbol plot of free body nodal forces.

Abaqus/CAE Usage:
Visualization module:

Result→Field Output: Symbol Variable: FREEBODY

Reference:

Abaqus/CAE User’s Manual

• “Producing a symbol plot of free body nodal forces,” Section 44.4, in the online HTML version of this

manual

13.5 Enhanced query options for probing the model

Product: Abaqus/CAE

Benefits: You can now probe a model plot for all of the direct components of a tensor variable or for all of

the principal components of a vector variable, rather than for just the selected component. In addition, you

can now specify multiple labels at the same time when you add nodes or elements to a query by their labels,

and you can probe a model plot for nodes or elements from a particular display group. These enhancements

improve usability and offer more customization options for probing values in a model.

Description: The probe functionality includes the following enhancements:

• You can now launch the Probe Values dialog box more quickly by clicking the new button in the

Visualization module toolbox.

• The Probe Values dialog box now enables you to display all of the component values for a tensor or

vector variable and to write these values to a file. Figure 13–5 shows the probe functionality displaying

all of the direct components of Mises stress. The figure also illustrates the reorganization of options

in the Field Output and Probe Values portions of the dialog box. These options now take up less

vertical space, which enables you to minimize the size of the dialog box and display a larger amount of

the viewport as you pick values.

For tensor quantities you can query for the selected invariant or component for all six direct

components of the tensor or for all three principal components of the tensor. For vector variables you

can query for either the resultant vector value or for one of the individual component values.
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Figure 13–5 Probe Values dialog box with all direct components displayed for Mises stress.

• When you add nodes or elements to a probe by keying in their IDs, Abaqus/CAE now enables you to

specify a list of comma-separated IDs at the same time.

• You can now probe values from all the nodes or elements in a particular display group. If you choose

Select a display group and specify one of the display groups in your session, Abaqus/CAE adds rows

to the data table for all the nodes or elements in that display group.

• You can create a new display group using the group of nodes or elements in the data table by clicking

mouse button 3 in the data table and selecting Create Display Group.

Abaqus/CAE Usage:
Visualization module:

Click from the toolbox: Select a display group and Components

Reference:

Abaqus/CAE User’s Manual

• “Using the Query toolset to probe the model,” Section 50.2, in the online HTML version of this manual

13.6 Controlling plot state and Field Output toolbar synchronization

Product: Abaqus/CAE
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Benefits: You can now control whether the plot state in the current viewport should be synchronized with

the field output variable selections in the Field Output toolbar. This enhancement provides greater flexibility

for display of results data.

Description: The Field Output toolbar now includes the Synchronize Plot State tool. By default, this

tool is toggled on, and Abaqus/CAE changes the plot state automatically if you select a new variable from

the toolbar that would require a change of plot state in the current viewport. However, when this option is

toggled off, you can modify the field output variable selections without automatically switching plot states in

the current viewport.

Abaqus/CAE Usage:
Visualization module:

Field Output toolbar: toggle

Reference:

Abaqus/CAE User’s Manual

• “Using the field output toolbar,” Section 41.4.2

13.7 Saving and operating on history output X–Y data simultaneously

Product: Abaqus/CAE

Benefits: Abaqus/CAE is enhanced to allow you to save and operate on history output data at the same time.

Description: When saving history data from theSave XY Data As dialog box, you can now apply any of the

Abaqus/CAE built-in operations to the data set. The available operations include a variety of mathematical,

trigonometric, logarithmic, exponential, and other functions. Figure 13–6 shows some of the single-operand

functions available.

If you are saving two history output variables at the same time, there are several new dual-operand

functions available:

• append((XY,XY))

• combine((XY,XY))

• power((XY,XY))

If you are saving three or more history output variables at the same time, there are two newmulti-operand

functions available:

• append((XY,XY,...))

• vectorMagnitude((XY,XY,XY))
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Figure 13–6 Operating on X–Y history data when saving.

In addition, you can now change the prefix of the data object name when saving multiple history output

X–Y data sets. The default data object names are XYData-1, XYData-2, etc.; you can edit the XYData portion

of the data object name to specify a new prefix.

Figure 13–7 Saving a data object with name NodalDisplacement-1.

Abaqus/CAE Usage:
Visualization module:

Tools→XY Data→Create; ODB history output; select output variables;
Save As; select Save Operation
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References:

Abaqus/CAE User’s Manual

• “Saving an X–Y data object,” Section 46.2.6

• “Overview of X–Y data operations,” Section 46.4.4

13.8 Toolbox button for ply stack plot options

Product: Abaqus/CAE

Benefits: A new button in the Visualization module of Abaqus/CAE provides quicker access to ply stack

plot options.

Description: The button in the Visualization module toolbox invokes the Ply Stack Plot Options
dialog box.

Abaqus/CAE Usage:
Visualization module:

Click from the toolbox

Reference:

Abaqus/CAE User’s Manual

• “An overview of ply stack plot options,” Section 52.2.1, in the online HTML version of this manual
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14. User subroutines, utilities, and plug-ins

This chapter discusses additional user programs that can be run with Abaqus. It provides an overview of the

following enhancement:

• “Defining damage initiation criterion via user subroutine UDMGINI,” Section 14.1

14.1 Defining damage initiation criterion via user subroutine UDMGINI

Product: Abaqus/Standard

Benefits: This user subroutine allows you to customize damage initiation criterion.

Description: User subroutine UDMGINI is used to specify user-defined damage initiation criterion.

References:

Abaqus Keywords Reference Manual

• *DAMAGE INITIATION

Abaqus User Subroutines Reference Manual

• “UDMGINI,” Section 1.1.23
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15. Abaqus Scripting Interface

This chapter discusses using the Abaqus Scripting Interface to write user scripts. Abaqus makes every attempt

to be backward compatible and can execute most Abaqus Scripting Interface scripts from previous releases

of Abaqus. However, backward compatibility is not guaranteed beyond several releases of Abaqus, and it

is recommended that you upgrade your commands to the most recent release. A complete list of Abaqus

Scripting Interface commands that have changed is included in “Summary of Abaqus Scripting Interface

changes between Abaqus 6.10 and Abaqus 6.10-EF” in the Abaqus Scripting Reference Manual.

This chapter provides an overview of the following enhancements:

• “Setting the last main file to open on startup in the Abaqus PDE,” Section 15.1

• “Support for NumPy library for Python in Abaqus,” Section 15.2

15.1 Setting the last main file to open on startup in the Abaqus PDE

Product: Abaqus/CAE

Benefits: The Abaqus Python Development Environment (PDE) can now automatically reopen the main

file that was selected upon your last session. This enhancement improves the ease of use of this functionality.

Description: If you toggle on the Set Last Main File on Startup setting during your Abaqus PDE session,

the Abaqus PDE will automatically reopen the most recently selected main file the next time you open the

utility. The main file is the script being tested by the Abaqus PDE environment.

Abaqus/CAE Usage:
All modules:

File→Abaqus PDE: Settings→Set Last Main File on Startup

Reference:

Abaqus Scripting User’s Manual

• “Selecting the settings for use with a file,” Section 7.2.4

15.2 Support for NumPy library for Python in Abaqus

Products: Abaqus/Standard Abaqus/Explicit Abaqus/CAE

Benefits: Abaqus now supports the NumPy extension to Python for mathematical functions replacing its

predecessor, Numeric, which is no longer supported. Support for NumPy expands the library of available

mathematical functions and provides improved performance.
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Description: The Numeric library of mathematical functions for Python has been deprecated, so Abaqus

now supports NumPy. The NumPy library includes a Numeric-compatible module named oldnumeric,

which replicates all of the functionality in the deprecated library. To use the functions previously available

in Numeric, issue the following command from a command prompt or from the CLI in Abaqus/CAE:

>> import numpy.oldnumeric as Numeric

For more information about the numpy module, see numpy.scipy.org.

The upgradeScript utility that upgrades your Python scripts for the new functionality in Abaqus

will also account for this mathematical library change.
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16. Summary of changes

This section summarizes the changes and the additions that have been made to the items that define an Abaqus

model, including elements, keywords, user subroutines, and output variables. For more information on these

modifications, refer to the preceding chapters.

The following identifiers are used:

new New in Abaqus 6.10-EF.

mod Existed in Abaqus 6.10 but has been modified or enhanced in Abaqus 6.10-EF.

rem Existed in Abaqus 6.10 but has been removed in Abaqus 6.10-EF.

(S) New, modified, or removed in Abaqus/Standard.

(E) New, modified, or removed in Abaqus/Explicit.

(C) New, modified, or removed in Abaqus/CFD.

16.1 Changes in Abaqus elements

This section summarizes the changes and the additions that have been made to the elements that can be used

in an Abaqus model.

new (S) C3D4P

4-node linear coupled pore pressure element.

new (S) C3D6P

6-node linear coupled pore pressure element.

new (C) FC3D6

6-node triangular prism fluid element.

16.2 Changes in Abaqus options

This section summarizes the changes and the additions that have been made to the options that define an

Abaqus model.

mod (S) *AMPLITUDE

The SCALEY and SHIFTY parameters are no longer supported for amplitudes

defined by user subroutines.

mod (E) *AQUA

This option can now be used in Abaqus/Explicit to define the steady fluid field for

submerged structures.
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mod (S) *BEAM GENERAL SECTION

Use the new LUMPED parameter to specify the mass matrix that will be used

for linear Timoshenko beam elements in frequency extraction and modal analysis

procedures.

Use the new TAPER parameter to define linear section behavior of tapered cross-

sections.

mod (S) *BEAM SECTION

Use the new LUMPED parameter to specify the mass matrix that will be used

for linear Timoshenko beam elements in frequency extraction and modal analysis

procedures.

Use the new TAPER parameter to define linear section behavior of tapered cross-

sections.

mod (E) *CLOAD

Load types TSB, TFD, TWD, and TSI are now available in Abaqus/Aqua working

with Abaqus/Explicit.

mod (E) *CONTACT CONTROLS ASSIGNMENT

The default value for the TYPE parameter is now ENHANCEDEDGETRACKING.

mod (S) *DAMAGE EVOLUTION

Use the new FAILURE INDEX parameter to define the damage evolution laws

corresponding to each failure mechanism specified in a user-defined damage

initiation criterion for enriched elements.

mod (S) *DAMAGE INITIATION

A new value is available for the CRITERION parameter. Set CRITERION=USER

to specify a user-defined damage initiation criterion for enriched elements.

Use the new FAILURE MECHANISMS parameter to define the total number of

failure mechanisms to be specified in a user-defined damage initiation criterion.

Use the new PROPERTIES parameter to define the number of material constants

being specified for a user-defined damage initiation criterion.

mod (S) *DISTRIBUTION

A distribution of membrane thickness can now be specified on the data lines.

mod (E) *DLOAD

Load types PB, FDD, FDT, FD1, FD2, WDD, WD1, WD2, FI, FI1, and FI2 are now

available in Abaqus/Aqua working with Abaqus/Explicit.

mod (S)(E) *DYNAMIC

Use the new SINGULAR MASS parameter in Abaqus/Standard to control velocity
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and acceleration adjustments if a singular global mass matrix is detected during

initialization or during contact impact/release computations.

The “improved” element time estimation method in Abaqus/Explicit is now applied

to three-dimensional continuum elements, in addition to elements with plane stress

formulations.

mod (E) *DYNAMIC TEMPERATURE-DISPLACEMENT

The “improved” element time estimation method is now applied to three-

dimensional continuum elements, in addition to elements with plane stress

formulations.

mod (S)(E) *ELEMENT OUTPUT

Use the new EXTERIOR parameter for field output to define an element output set

consisting of all the exterior elements in the model.

mod (E) *FLUID EXCHANGE

Use the new CAVITY PRESSURE parameter to apply the fluid pressure on the fluid

exchange surface or to model fluid exchange through a vent and apply the fluid

pressure as an equivalent load on the perimeter of the surface.

mod (S)(E) *INITIAL CONDITIONS

Use the new DRIVING ELSETS parameter to define the source region from where

the temperatures are read from a previous analysis and the target region onto which

the temperatures are mapped in the current analysis.

mod (S) *MEMBRANE SECTION

Use the newMEMBRANETHICKNESS parameter to define membrane thicknesses

using distributions.

mod (S)(E) *NODE OUTPUT

Use the new EXTERIOR parameter for field output to define a node output set

consisting of all the exterior nodes in the model.

mod (S) *RESPONSE SPECTRUM

Two new values are available for the COMP parameter. Set COMP=R40 or R30

to use the 40% rule or 30% rule, respectively, for summing directional excitation

components as recommended by the ASCE 4–98 standard.

Two new values are available for the SUM parameter. Set SUM=DSC to use the

double sum combination method. Set SUM=GRP to use the grouping method.
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mod (E) *SECTION CONTROLS

This option now allows the specification of a scale factor for the drill stiffness of

shell elements in Abaqus/Explicit.

For Eulerian EC3D8R elements, the pure viscous form of hourglass control is the

default form and the integral viscoelastic form of hourglass control is not supported.

mod (E) *SHELL GENERAL SECTION

This option now allows the specification of a distribution to define composite layer

thickness for conventional shell elements in an Abaqus/Explicit analysis.

mod (E) *SHELL SECTION

This option now allows the specification of a distribution to define composite layer

thickness for conventional shell elements in an Abaqus/Explicit analysis.

mod (S) *SPECTRUM

Use the new ABSOLUTE, AMPLITUDE, CREATE, DAMPING GENERATE,

EVENT TYPE, FILE, RELATIVE, and TIME INCREMENT parameters to create

a spectrum from a user-specified amplitude that describes a dynamic event.

mod (S)(E) *TEMPERATURE

Use the new DRIVING ELSETS parameter to define the source region from where

the temperatures are read from a previous analysis and the target region onto which

the temperatures are mapped in the current analysis.

mod (E) *WAVE

This option is now available in Abaqus/Explicit to define the wave field for

submerged structures. Only fifth-order Stokes wave theory is available in

Abaqus/Explicit.

mod (E) *WIND

This option is now available in Abaqus/Explicit to define the wind field for

submerged structures.

16.3 Changes in Abaqus user subroutines

This section summarizes the changes and the additions that have been made to user subroutines that can be

used in an Abaqus model.

new (S) UDMGINI
User subroutine to define the damage initiation criterion for enriched elements.
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16.4 Changes in Abaqus output variable identifiers

This section summarizes the changes and the additions that have been made to output variable identifiers used

in Abaqus.

Whole element variables

mod (E) CA

The connector relative acceleration, previously available only for history output, can

now be requested for field output.

mod (E) CDIP

The components of connector plastic motion-based damage initiation criterion in all

directions, previously available only for history output, can now be requested for

field output.

mod (E) CFAILST

The all flags for connector failure status, previously available only for history output,

can now be requested for field output.

mod (E) CP

The connector relative position, previously available only for history output, can

now be requested for field output.

mod (E) CUPEQ

Equivalent plastic relative motion for a coupled plasticity definition is now available

in addition to equivalent plastic relative displacements and rotations in all directions.

mod (E) CUPEQC

Equivalent plastic relative motion for a coupled plasticity definition is no longer

available for field output.

mod (E) CV

The connector relative velocity, previously available only for history output, can now

be requested for field output.

new (S) CYCLEINIXFEM

Number of cycles to initialize the crack at the enriched element.

mod (S) FLUXS

Current values of distributed (heat or concentration) fluxes (not available for

nonuniform fluxes), including those imported using the HFL co-simulation field ID.
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Element integration point variables

mod (S) FV

Predefined field variables, including those imported using the FV
i
co-simulation field

ID.

new (S)(E) LOCALDIRn

Direction cosines of the local material directions for an anisotropic hyperelastic

material model.

new (S) MISESONLY

Mises equivalent stress. When MISESONLY is requested instead of MISES, the

stress components are not written to the output database (.odb) file; consequently,
the size of the database is reduced.

new (S) PRESSONLY

Equivalent pressure stress. When PRESSONLY is requested instead of PRESS, the

stress components are not written to the output database (.odb) file; consequently,
the size of the database is reduced.

new (E) TEMPMAVG

Temperature, computed as a mass fraction weighted average of all materials in the

element.

Integrated variables

new (E) MASSEUL

Total mass of each Eulerian material instance in the element set.

new (E) VOLEUL

Total volume of each Eulerian material instance in the element set.

Element variables

new (C) TURBEPS

Energy dissipation rate.

new (C) TURBKE

Turbulent kinetic energy.

Nodal variables

mod (S) CF

All components of point loads and concentrated moments, including loads imported

using the CF co-simulation field ID.
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mod (S) CFF

Concentrated fluid flow at a node, including those imported using the CFLOW co-

simulation field ID.

mod (S) CFL

All concentrated flux values, including those imported using the CFL co-simulation

field ID.

mod (S) NT

All temperature values at a node, including those imported using the TEMP co-

simulation field ID.

new (C) TURBEPS

Energy dissipation rate.

new (C) TURBKE

Turbulent kinetic energy.

Element face variables

mod (S) P

Uniformly distributed pressure load on element faces, including those imported

using the PRESS co-simulation field ID.
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I. Product Index

Abaqus/Standard

Section 3.1 Parallel ordering for the direct sparse solver

Section 3.2 Thread parallel element and contact search calculations for transient fidelity

dynamic analyses

Section 3.3 Parallel support for Abaqus/Standard to Abaqus/Standard import

Section 3.4 Parallel support for Abaqus/Standard co-simulation

Section 4.6 Diagnostics for modeling errors associated with mass properties

Section 4.7 Thickness and material orientation distributions for membrane elements and

sections

Section 5.2 Improved import and translation of membrane data from Nastran models

Section 6.2 Continued enhancements to the XFEM-based crack propagation capability

Section 6.4 Enhancements to coupled structural-acoustic analysis

Section 6.5 AMS eigensolver performance improvement

Section 6.6 Enhanced iterative solver capability to handle dense linear constraints

Section 6.7 Defining a spectrum using values of S as a function of frequency and damping

in Abaqus/CAE

Section 6.8 Creating a spectrum from a user-specified amplitude in Abaqus/Standard

Section 6.9 New modal and directional summation methods for response spectrum analysis

Section 6.10 Using uncoupled eigenmodes to generate a coupled acoustic-structural

substructure

Section 8.1 New linear pore pressure elements

Section 8.2 Tapered beams and improved mass formulation

Section 9.1 Three-dimensional pressure penetration loading

Section 9.4 Specifying the source and target regions for temperature mapping

Section 10.2 Improvement to coupling definition

Section 11.1 Contact stress output improvements

Section 11.2 Penalty stiffness for contact involving gaskets

Section 13.1 Output database size reduction

Section 14.1 Defining damage initiation criterion via user subroutine UDMGINI
Section 15.2 Support for NumPy library for Python in Abaqus

Abaqus/Explicit

Section 4.2 Application of fluid cavity pressure on the fluid exchange surface

Section 4.8 Composite layer thickness distribution for shell elements

Section 5.2 Improved import and translation of membrane data from Nastran models

Section 6.1 Change in default element stable time estimation for three-dimensional

continuum elements
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Section 9.4 Specifying the source and target regions for temperature mapping

Section 9.5 Explicit dynamics analysis using Abaqus/Aqua

Section 10.2 Improvement to coupling definition

Section 11.3 Edge-to-edge general contact enhancement

Section 13.1 Output database size reduction

Section 15.2 Support for NumPy library for Python in Abaqus

Abaqus/CFD

Section 6.3 New RNG k–epsilon turbulence model for fluid dynamic analysis

Section 8.3 New 6-node triangular prism for fluid flow problems

Section 13.2 Streamlines

Abaqus/CAE

Section 2.2 Context bar list navigation in Abaqus/CAE

Section 2.3 Copying step-dependent objects to a different step

Section 4.1 Substructures in Abaqus/CAE

Section 4.3 Enhancements to the offset, extend, and blend face tools

Section 4.4 Creating a wire-from-edge feature

Section 4.5 Adding a mirror feature to a part

Section 4.7 Thickness and material orientation distributions for membrane elements and

sections

Section 5.1 Exporting models in OBJ format

Section 5.2 Improved import and translation of membrane data from Nastran models

Section 6.3 New RNG k–epsilon turbulence model for fluid dynamic analysis

Section 6.7 Defining a spectrum using values of S as a function of frequency and damping

in Abaqus/CAE

Section 6.9 New modal and directional summation methods for response spectrum analysis

Section 7.1 Material calibration

Section 8.1 New linear pore pressure elements

Section 8.2 Tapered beams and improved mass formulation

Section 8.3 New 6-node triangular prism for fluid flow problems

Section 9.1 Three-dimensional pressure penetration loading

Section 9.2 Changing the coordinate system for symmetry boundary conditions

Section 9.3 Total force distribution option for pressure loads

Section 10.1 Automatic shell-to-solid coupling constraints

Section 12.1 Tetrahedral meshing enhancements

Section 12.2 Mesh stack orientations

Section 13.1 Output database size reduction

Section 13.2 Streamlines

Section 13.3 Displaying constraints in the Visualization module

Section 13.4 Displaying free body nodal forces in symbol plots
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Section 13.5 Enhanced query options for probing the model

Section 13.6 Controlling plot state and Field Output toolbar synchronization
Section 13.7 Saving and operating on history output X–Y data simultaneously

Section 13.8 Toolbox button for ply stack plot options

Section 15.1 Setting the last main file to open on startup in the Abaqus PDE

Section 15.2 Support for NumPy library for Python in Abaqus

Abaqus/AMS

Section 6.5 AMS eigensolver performance improvement

Abaqus/Aqua

Section 9.5 Explicit dynamics analysis using Abaqus/Aqua
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